Shortcuts


Toolbar Shortcut steps:

· Create a file folder i.e. Shortcuts 
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· Right Click Tool bar

· Select “Toolbars”
· Select “New Toolbar” select file the above file folder i.e. Shortcuts
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Use keyboard shortcuts

The mouse, one of the greatest advances in computing history, provides you with an intuitive point-and-click method for using your computer. Depending on the type of work you're doing, however, sometimes using a mouse actually slows you down. If you are a good typist, taking your hands away from the keyboard to move the mouse can use up a few seconds. Over the course of a full day, you could save several minutes by using keyboard shortcuts instead of the mouse.

You can use your keyboard instead of your mouse to do these three tasks:

	•
	Start a program

	•
	Navigate menus

	•
	Minimize, maximize, and close windows


Start a program using a keyboard shortcut

The Start menu is great for finding programs, but its multiple levels of folders can be time consuming to navigate. If there is a program you start frequently, you should set a keyboard shortcut for it so that you can start the program without taking your hands off the keyboard.

To set a keyboard shortcut to start a program
	1.
	Click the Start menu, and then click All Programs. Right-click the program that you want to start with a keyboard shortcut, and then click Properties.
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	2.
	Click in the Shortcut key box. Now press the letter on your keyboard that you want to use to start the program. Make it easy to remember—for example, press I for Microsoft Internet Explorer.

Note: You can use either uppercase or lowercase letters when creating your keyboard shortcuts—and when accessing them later. In the Shortcut key box, Microsoft Windows XP automatically adds Ctrl + Alt + before the key you pressed. When you want to start the program, hold down both the CTRL and ALT keys simultaneously, while also pressing the letter you chose. This way, your program won't start every time you type that letter.
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	3.
	Click OK.
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	4.
	Now test your shortcut. Hold down the CTRL and ALT keys, and then press the letter you chose. If you find it difficult to hold down two keys at once, read Turn on the Sticky Keys feature. Your program should start.
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When your friends see you start up programs without touching your mouse, they just might think you have a psychic connection with your computer!




 HYPERLINK "http://www.microsoft.com/windowsxp/using/setup/tips/kbshortcuts.mspx" \l "top" 
Top of page

Navigate menus using the keyboard

You can speed up tasks in almost any program by choosing menu items using your keyboard instead of your mouse. This operation is particularly handy when you're performing repetitive tasks.

To control menus using your keyboard
	1.
	With your program open, press the ALT key. Notice that one letter on each menu name is now underlined. To open the menu, press the underlined key. For example, in Internet Explorer, the View menu name shows the V underlined after you press the ALT key. To open the View menu, press the ALT key, and then press V.
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	2.
	Now, each menu item will show one letter underlined. To access or activate the menu item you want, simply press the underlined key. For example, in Internet Explorer, after you open the View menu, the Privacy Report menu item shows the V underlined. Instead of clicking Privacy Report with your mouse, you can just press the V key.
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	3.
	You can also choose menu commands by pressing key sequences quickly, without waiting for the menus to open. For example, to quickly view a Web page's privacy report in Internet Explorer, press ALT, V, V. Similarly, to save a Web page in Internet Explorer, you would normally click the File menu, and then click Save As. To choose the same commands using your keyboard, press ALT, F, A.





 HYPERLINK "http://www.microsoft.com/windowsxp/using/setup/tips/kbshortcuts.mspx" \l "top" 
Top of page

Control windows using your keyboard

If you like to keep four or five windows open while you work (or play) on your computer, you'll appreciate knowing these keyboard shortcuts. You can quickly switch between your Web browser, e-mail, instant message windows, and other programs without taking your hands off the keyboard.

	Action
	Shortcut

	Minimize a window to your taskbar
	ALT, SPACEBAR, N

	Maximize a window so it takes up your whole desktop
	ALT, SPACEBAR, X

	Restore a window so it's visible but doesn't take up your whole desktop
	ALT, SPACEBAR, R

	Close a window
	ALT+F4

	Switch to the last window you had open
	ALT+TAB

	Switch to any window
	Hold down the ALT key, and press TAB until the window you want is active


Programs often start up in a "restored" state, where the window takes up only part of the screen. To maximize the window so that it takes up the entire screen, press the ALT key, press the SPACEBAR, and then press X. This will feel natural after you do it a few times, and you will feel much more efficient while using your computer.

	Handy Keyboard Shortcuts in Microsoft Office 


	

	


	If you're a Microsoft Office user who touch-types, you might prefer the keyboard to the mouse for entering commands. Odds are, though, that you wind up using the mouse, because Windows and Office keyboard shortcuts are difficult to remember, and trying to find them is a little like searching for the hidden goodies in an adventure program. Once found, though, shortcuts can prove invaluable time-savers.

This is not a list of every shortcut in Windows and Office. We've concentrated on those we've found most helpful. We won't delve into the shortcuts you probably know already, such as those that copy (Ctrl-C), cut (Ctrl-X), or paste (Ctrl-V) objects.

Don't try to learn all these key combinations at once. Pick a few that fit the way you work and use them for a while until they're automatic, then try a few more. To help you remember, we've added mnemonics where we could, along with notes where appropriate. All these shortcuts work in Windows 95, 98, Me, NT 4.0, and 2000, except where noted. Some require a keyboard with a Windows key (the key with a flying Windows icon on it). Windows-key shortcuts are among the most useful—and most overlooked.

Moving Around Windows and the Desktop

Shortcuts that let you move from one window to another easily, get to the Windows desktop, or move around the desktop can speed you up considerably.

  Switch among applications: Windows-Tab or Alt-Tab. 

The Windows-Tab combination cycles through the taskbar buttons. When the program you want is selected, hit Enter to switch to that window. If more than one program is running, Alt-Tab brings up the task-switching window. Immediately releasing the keys switches you to the previous application. To jump to one of the other running programs instead, release Tab, but keep Alt held down. Each succeeding press of Tab moves the program selection box to the next application. Releasing the Alt key switches you to the selected program. If only two applications are running, Alt-tab toggles between them.

  Open the Start menu: Ctrl-Esc or Windows. 

Either shortcut will open the Start menu. Use the Up and Down Arrow keys to move through the menu, and the Enter key to choose an item. The two shortcuts vary slightly depending on your version of Windows. Ctrl-Esc, Esc leaves the Start button selected but not pressed. In Windows 95, 98, and NT 4.0 (but not Windows 2000 and Me), Windows, Esc will return you to the window or desktop selection you were working with previously.

  Go to the Quick Launch toolbar and launch a program: Ctrl-Esc, Esc, Tab, select with Arrow keys, Enter.

  Minimize all open Windows and reveal the desktop: Windows-M or Windows-D.
Mnemonics: This one's easy to remember; M for Minimize all and D for desktop. Note that Windows-D doesn't work under Windows 95, but Windows-M does. 

  Restore all Windows you previously minimized with Windows-M or Windows-D: Shift-Windows-M or repeat Windows-D: Shift-Windows-M or repeat Windows-D.

  Move within the Windows Desktop and select items: Tab, Arrow, Enter. 

Once at the desktop, use the Tab key to cycle through the Start button, Quick Launch toolbar, other toolbars, taskbar button area, and icons on the desktop (and those in the system tray in Windows 2000). Use the Arrow keys to move around within any of these areas of the desktop or taskbar. Use the Enter key to select items. You must, for example, select the Start button to open the Start menu.

Windows Housekeeping Chores

These shortcuts can help you with day-to-day housekeeping in Windows.

  Open the Run dialog box: Windows-R.
Mnemonic: The Windows Run dialog. 

  Start Windows Explorer: Windows-E.
Mnemonic: Windows Explorer. 

  Find a File (from the Windows desktop): Windows-F or F3.
Mnemonic: Windows Find file dialog box. 

  Open the System Properties dialog box: Windows-Break.
Mnemonic: Windows is broken; check the system properties. 

  Rename the selected object: F2.
Mnemonic: This is the same command Excel uses for editing the currently selected cell. This command and the next one work within programs, too. For example, you can use these commands when working in the File | Open dialog box in Word or Excel. Note that after you select text in Word, F2 begins the operation of moving the current selection. You then move the insertion cursor to the desired location and hit Enter. 

  Delete selected objects without sending them to the Recycle Bin: Shift-Delete.
Mnemonic: A slightly shifted version of what happens when you hit Delete, which sends the objects to the Recycle Bin. Be careful with this command. Under some conditions, it will delete a file without asking for confirmation first. 

  Bypass the CD-ROM AutoRun feature: Hold down the Shift key while you insert the disk.
This is an invaluable tool when you have to remove a disk during installation (to read the CD key, for example), then reinsert the disk. 

  View the Properties dialog for a selected object: Alt-Enter.
This works for such disparate objects as icons on the desktop, printers, hard drives, and the taskbar. 

Windows-Wide Shortcuts

The shortcuts in this category work not only in Windows itself, but also in most Windows applications. Some of these shortcuts relate to the windows of a particular application. Others relate to features you'll find in almost any Windows program, such as drop-down list boxes.

  Restore, Move, Size, Minimize, Maximize, or Close the main window of the currently selected program: Alt-Spacebar, letter key (from those underlined above), or Alt-Spacebar, Arrow, Enter.

Alt-Spacebar opens the System menu, which will appear on-screen even if the application window is mostly off-screen. You can move the window back to a workable position using the Arrow keys and then hit Enter to set it down. 

  Restore, Move, Size, Minimize, Maximize, or Close the currently selected window within a program: Alt-hyphen, letter key, or Alt-hyphen, Arrow, Enter. 

  Open a context menu: Shift-F10, letter key, or Shift-F10, Arrow, Enter.

This is particularly useful in a program like Word when, for example, you want to call up the editing context menu but don't want to take your fingers from the keys to right-click. 

  Open a drop-down list box: Alt-Down Arrow.
Mnemonic: Down box, Down Arrow. This is especially helpful when you're filling in database forms (in Microsoft Access, for example). It's also useful when working in a dialog box. 

  Cycle through the tabs in a dialog box: Ctrl-Tab and Ctrl-Shift-Tab.
Mnemonic: Control your way from tab to tab. Ctrl-Tab goes from left to right, Ctrl-Shift-Tab moves from right to left. 

  Switch from window to window within the same program: Alt-F6. 

This won't work with all windows. It will, for example, toggle between a Find window and a document window in Microsoft Word, but it won't toggle between one document window and another. The command in Word for cycling through the open document windows is Ctrl-F6.

  Basic font formatting for bold, underline, italic: Ctrl-B, Ctrl-U, Ctrl-I. 

You probably know these work in the Office programs you use, but try them in other programs as well; they may work.

  Undo: Ctrl-Z.
Mnemonic: Zap that. Again, this works throughout Windows, if not in every program. 

Microsoft Word Shortcuts

Word offers over 300 shortcuts as shipped, not including the menu shortcuts. This adds up to more shortcuts than any reasonable person would be willing to memorize. There are a few, however, that we've found are worth the effort.

  Expand an autotext entry: F3.
If you use autotext very often, you'll get the hang of this one. Simply type the abbreviation (such as your initials for your address) and hit F3 to replace the abbreviation with the fill entry. 

  Change the case of letters: Shift-F3.
The effect of this shortcut depends on the selected text. The basic behavior cycles through all caps, all lowercase, and title capitalization (the first letter of each word capitalized). If the selection includes a sentence break, the shortcut cycles through all caps, all lowercase, and capitalization of the first word in each sentence. 

  Check spelling: F7.
F7 by itself performs a spell-check on the entire document. If you select a word or section first, however, F7 checks the spelling of only that word or selection. If you have the Check Spelling As You Type feature turned on, this shortcut probably won't interest you. If you find that feature distracting and keep it off, you might find this shortcut quite useful. 

  Check the thesaurus: Shift-F7.
Mnemonic: There's not really a good mnemonic, but remembering that the F7 key is associated with both spelling and thesaurus commands might help. Shift-F7 checks the thesaurus for the word the cursor is on or just past. 

  Update fields: F9.
Mnemonic: Again, there's not really a good mnemonic. All shortcuts dealing with fields use the F9 function key, though. Remember that much and you can, at the very least, experiment with various keystroke combinations. F9 by itself updates the selected fields, if any, or just the field the cursor is in. 

  Switch between the field code and field result for selected fields: Shift-F9.
Mnemonic: Shift between selected field codes and field results. 

  Switch between showing all field codes and their results: Alt-F9.
Mnemonic: Show all (Alt) codes or results. 

  Insert field markers: Ctrl-F9.
Mnemonic: Control what goes into the field. If you know the field codes you need to enter, use Ctrl-F9 to insert both open and close markers for the field quickly, then type your codes between them. Hit F9 to calculate the field result. 

  Unlink a field: Shift-Ctrl-F9.
Mnemonic: Shift control from the field to the field result. This converts a calculated field result into permanent text or a permanent graphic. 

  Insert Date field: Alt-Shift-D.
Mnemonic: Date. To insert the date as text, type Alt-Shift-D, Backspace, Ctrl-Shift-F9. 

  Insert Time field: Alt-Shift-T.
Mnemonic: Time. Again, to make the insertion as text, follow the shortcut with Ctrl-Shift-F9. 

  Move to the Style drop-down box to pick a style: Ctrl-Shift-S.
Mnemonic: Take Control to shift the Style. Once you get to the Style text box, you can open the drop-down list with Alt-Down Arrow. 

  Format characters as superscript: Ctrl-+. 

  Format characters as subscript: Ctrl-= (equal sign).
Mnemonic: Superscript is +. Subscript is the unshifted form of +. 

  Return font to the default format for the style: Ctrl-Spacebar.
If you depend on styles for formatting, this is one of the most important shortcuts to learn—particularly if you collaborate with others who may not be familiar with styles. 

  Toggle between showing and hiding nonprinting characters: Ctrl-Shift-* (asterisk).
This is equivalent to clicking on the Show/Hide icon in the standard toolbar. 

  Move the paragraph up: Alt-Shift-Up Arrow. 

  Move the paragraph down: Alt-Shift-Down Arrow.
This moves the paragraph containing the cursor or selection one paragraph marker at a time. 

  Cycle the selected paragraph through all formats in the Style list: Alt-Shift-Right (or Left) Arrow. 

Microsoft Access And Excel Shortcuts

Here are two handy shortcuts that work for both Access and Excel. See the sidebar for more.

  Enter time: Ctrl-: (colon). 

  Enter date: Ctrl-; (semicolon).
Mnemonic: You separate hours and minutes with a colon, so use a colon for time. The date shortcut is the unshifted colon key.


	Access Tips 
03.20.01 


	

	Entering data and working with records.
Enter the default value for a field: Ctrl-Alt-Spacebar.

Enter the value that appears in the same field in the previous record: Ctrl-’ (apostrophe).

Add a new record: Ctrl-+.

Delete the current record: Ctrl--(minus sign).


	Excel Tips 
03.20.01 


	

	Edit or create a comment in the current cell: Shift-F2.

Move a comment that's being edited: Esc, Arrow keys.

Close a comment that's being edited: Esc, Esc.

Fill a selected range: Type the data, then Ctrl-Enter.

Copy the value from the cell above the current cell: Ctrl-Shift-" (quotation mark).

Copy the formula from the cell above the current cell: Ctrl-' (apostrophe).


	Key XP Shortcuts 
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By M. David Stone 

	Learn these helpful keyboard tricks to work more quickly and efficiently—without using your mouse.
One of the small joys of computer use is discovering a shortcut key that is so helpful you start using it every day. We covered some of the Microsoft Windows and Office shortcuts we find most useful in "Handy Keyboard Shortcuts" (www.pcmag.com/shortcuts), but there are hundreds of shortcuts available, and we had to leave out far more than we covered.

So here's a new collection of shortcut keys for Windows XP and Office XP, including some for features that are new to these versions, like the Language bar in Office XP. Many of these shortcuts depend on the Windows key (with the Windows logo on it) or the Application key (with an icon of a menu on it).


	Key XP Shortcuts

	Navigate Windows Help
Windows XP Help and Support Center is far more useful than earlier versions of Windows Help, so you're more likely to consult it often.

  Display Windows Help: Windows-F1. 

  Move through the list of help topics, articles, and other items showing: Tab or Shift-Tab. 

Pressing Tab moves you forward through the choices. Shift-Tab moves backward. To select an article or topic, launch a hyperlink, or see a definition, move to that item and hit Enter. You can also Tab to the Search box or use Alt-S and then enter a search phrase. Hit Enter to run the search. If the Help index is in the left pane, use the Up Arrow and Down Arrow keys instead of Tab and Shift-Tab to move through the index items.

  Move back or forward to a previously viewed topic: Alt–<Right Arrow> to move forward; Alt–<Left Arrow> to move back. 

This shortcut is equivalent to the Back and Forward icons on the toolbar. These also work in Internet Explorer, Windows Explorer, My Computer, and other windows with Back and Forward icons.

  Print the current help topic or current selection: Tab or Ctrl-Tab to go to the right pane; Ctrl-P to call up the Print dialog box and print. 

If you want to print just a portion of the Help information, select that portion before choosing Ctrl-P, and then in the Print dialog box, under Page Range, choose Selection. Note that you don't have to expand the sections in the topic; Windows automatically prints off-screen information.


	Key XP Shortcuts

	Windows-Wide Shortcuts
The shortcuts in this section will work just about anywhere in Windows, including most application programs.

  Select all the text in a pane: Ctrl-A. 

This shortcut selects all the text in the current pane of the Help screen and all the text in a Notepad, WordPad, or Word document. It works in Windows Explorer and Internet Explorer, too. This can be useful when you need to copy information to another window or application.

  Open the context menu for the currently selected item: Application key. 

The context-menu is what most people think of as the right-click menu—the list of options relevant to the selected object. Using the Application key is equivalent to—but easier than—using Shift-F10. This shortcut is particularly useful within programs. You can bring up the context menu for words in Word or cells in Excel without having to reach for the mouse.

  Turning on MouseKeys: Alt-<Left Shift>-<NumLock>. 

With MouseKeys, you can use the numeric keypad to move the mouse cursor. After activating MouseKeys, use the NumLock key to toggle the keypad between standard navigation keys and mouse keys; the Home, PgUp, End, and PgDn keys move the pointer diagonally. Use NumPad 5 (5 on the numeric keypad) to click, NumPad Plus (+) to double-click. To right-click, use NumPad Minus (-) and NumPad 5. When you type the shortcut combination on the numeric pad, you'll see a dialog box that includes a Settings button, so you can adjust MouseKey options.

If the MouseKey shortcuts don't work, go to the Control Panel and choose Accessibility Options, then the Mouse tab, and then the Settings button. In the Keyboard Shortcut section, make sure the Use shortcut check box is checked.

  Copy an image of the currently selected Window to the Clipboard: Alt-<PrintScr>. You can then paste the image into a document. Using Alt-<PrintScr> confines the capture to the currently selected window or dialog box, as opposed to <PrintScr>, which captures the entire screen. If no dialogs are open, Alt-<PrintScr> gives you a picture of the current app. 


	Key XP Shortcuts

	Windows Housekeeping
  Open My Computer: Windows-E. 

In versions prior to Win XP, Windows-E opens Windows Explorer, but the general idea behind this shortcut is that it lets you explore and manage your files easily.

  Lock your computer and hide the screen: Windows-L. 

If Windows XP is set to use Fast User Switching, this will bring up the Welcome screen and wait for you to log on again. (You must reenter your password.) If your machine is not set to use the Welcome screen or it's set to use the Welcome screen but not Fast User Switching, Windows-L will hide anything on-screen and bring up the Unlock Computer dialog box.

  Search for a computer on your network: Windows-Ctrl-F. 


	Key XP Shortcuts

	Office Shortcuts
Not all of the shortcuts in this section work in all Office XP apps, and those that do may not work exactly the same way in each program. But these shortcuts will work in at least Word, Excel, and PowerPoint, and their behavior is similar in each.

  Display the menu or message for a smart tag: Alt-Shift-F10. 

Once the menu is open, you can use the Up Arrow and Down Arrow keys to move through the menu. Hit Enter to choose an option or Esc to close the menu.

  Move between a document pane and an open task pane: F6. 

Depending on the program and how many panes are showing, you may need to press F6 more than once.

  Switch to the next or previous tab in a multitab dialog box: Ctrl-Tab for the next tab; Shift-Ctrl-Tab for the previous tab. 

  Select the buttons across the top of the Save As or Open dialog box: Use the Alt key plus the number that matches the position of the button, counting from left to right and starting with the Back Arrow icon (to the right of the Look In or Save In drop-down menu box). 

  Go back to the previous folder you looked in: Alt-1. 

  Go up one folder level: Alt-2. 

  Close the dialog box and search the Web: Alt-3. 

  Delete the currently selected folder or file: Alt-4. 

  Create a new subfolder: Alt-5. 

  Cycle among showing List, Details, Properties, and Preview views: Alt-6. 

  Open the Tools menu: Alt-7 or Alt-L. 

  Open the Look In or Save In list: Alt-I. 


	Key XP Shortcuts

	Language Bar Commands
With the exception of the shortcut to open the Correction dialog box, which seems to work only in Word, the Language bar shortcuts will work with any program that uses the Language bar, including Internet Explorer and Outlook Express.

  Turn the microphone on and off: Windows-V. 

  Switch the Language bar between Voice Command mode and Dictation mode: Windows-T. 

  Turn handwriting recognition on and off: Windows-H. 

  Open the Correction dialog: Windows-C.


	Key XP Shortcuts

	Word Shortcuts
  Insert a nonbreaking space: Ctrl-Shift-Spacebar. This is handy when you don't want a line to break in the middle of a phrase or name. 

  Insert a nonbreaking hyphen: Ctrl-Shift-Hyphen. This shortcut is useful when you don't want a phrase to break at a hyphen, as in Anna-Marie. 

  Insert the Euro symbol: Type 20ac followed by Alt-X. With this shortcut, you may have to add support for the Euro to your operating system to see the symbol on-screen. 

  Insert a tab character in a table cell: Ctrl-Tab. 

  Use Format Painter without the mouse: Ctrl-Shift-C to copy the format of selected text or text the cursor is in. Then select the target text and press Ctrl-Shift-V to apply the format to that text. 

  Turn Track Changes on/off: Ctrl-Shift-E. 

  Switching views: Alt-V, P for Print Layout, for Normal, or O for Outline view. 

Switching among print layout, normal, and outline views is only marginally faster with shortcuts than with menu commands. But if you switch back and forth repeatedly, the difference is noticeable. There is no shortcut, however, for switching to Web view.

  Switch to print layout view: Alt-Ctrl-P. 

  Switch to normal view: Alt-Ctrl-N. 

  Switch to outline view: Alt-Ctrl-O. 

  Switch to or from Print Preview: Alt-Ctrl-I.


	Key XP Shortcuts

	Excel Shortcuts
  Move to the next worksheet: Ctrl-PgDn. 

  Move to the previous worksheet: Ctrl-PgUp. 

  Select multiple worksheets: Shift-Ctrl-PgDn. This command selects the current worksheet and the one that follows. If you hold down the Shift and Ctrl keys, each press of PgDn extends the selection forward by one worksheet. Shift-Ctrl-PgUp works the same way but selects the current and previous worksheets. 

  Entering currency characters: First make sure NumLock is on. Then hold down the Alt key and type the appropriate number from the list below. Release the Alt key only after typing the entire number. 

Cent (¢): 0162.

Pound sterling (£): 0163.

Yen (¥): 0165.

Euro (€): 0128.

This technique works in many other apps as well, and it's worth trying in programs that don't offer better alternatives.


Top Tips & Tricks For Windows
ARTICLE DATE:  06.01.05
By Sarah Pike 

Reports on the next Microsoft Windows, still known only by its code name, Longhorn, are rampant, but it looks as if we'll have Windows XP to kick around for a while longer. Since we met XP back in 2001, we've been generally pleased with its power and stability, but often disappointed by the number of workarounds and nearly hidden settings required to make our computers come a little closer to working for us, rather than the other way around. 

ADVERTISEMENT 
In this story we present our favorite Windows XP tips, including some of the best User to User questions and tips that our Solutions section has received since XP's inception. These will help you solve nagging Windows problems (er, quirks), make Windows suit your style better, make you more safe and secure, help you cooperate with multiple users, and improve performance when you're on the go with a laptop. 

Although the jury's still out on whether an Internet browser can be considered an integral part of an operating system, there's no doubt that it's an integral part of our lives. You'll find tips and workarounds for Microsoft's ubiquitous and controversial browser, Internet Explorer, followed by tips for using Mozilla's popular upstart, Firefox. For those accustomed to using IE, Firefox's many settings and options may seem blinding at first, but the browser's impressive market share shows that it's caught the eyes of quite a few users.

But whichever browser you use to surf the Internet, whether you use a desktop or a laptop, whether it's just you or a whole family using your system, don't forget: These machines were made to work for you. Consider the following 120 tips our little reminders to you of that.

Tipsters PC Magazine Labs lead analyst Neil J. Rubenking is our tipster extraordinaire. Additional tips were contributed by editorial intern and resident Firefox expert David Murphy, and PC Magazine Labs' Richard Fisco and M. David Stone.
General Tips
ARTICLE DATE:  06.01.05
By Sarah Pike 

Windows XP is a take-charge kind of operating system, and it's easy to sit back and leave it to its own devices, so to speak. But from start-up to shutdown, in the face of baffling errors to programs you don't use but can't get rid of, you can be more in control than you may have thought.

Control Which Programs Launch at Start-Up
Many of the programs you install on your system automatically configure themselves to launch at start-up, often invisibly. The truly essential ones, such as firewall and antivirus products, generally run as Windows services, working efficiently in the background. Other less important products like media players really don't need to be running constantly, if at all. These extra applications slow the boot process and then suck up system resources and CPU cycles.

There are many ways a program can launch at start-up. The System Configuration Utility rounds up all of the start-up programs in a single display. Launch it by choosing Run from the Start menu and entering msconfig. The Startup tab displays a complete list of the programs that launch at start-up. To disable any one of them reversibly, just uncheck the box at left. It should be safe to disable any of them, as only nonessential programs appear on the Startup tab. But leave the adjacent Services tab alone—disable some of those entries and you may disable Windows completely.

For an even simpler approach, you might want to try a start-up manager like Absolute Startup (for our review, see http://go.pcmag.com/utilityguide ).

Control Start-Up Launch Order
Windows checks various locations in the file system and Registry to determine which programs should launch at start-up, but gives you no real control over the launch order. Here's how to enforce a specific order, perhaps to connect to a VPN before launching a program that needs that connection.

If shortcuts to the start-up programs reside in the Start menu's Startup folder, move them to a new folder; otherwise, create a shortcut to each in a new folder. Open a command prompt, navigate to that new folder, and issue the command DIR /B > ORDERED.BAT. Enter NOTEPAD ORDERED.BAT to open the resulting batch file in Notepad. Use copy-and-paste to put the lines in the desired order. Surround each line with quotes and precede it with the START command, a pair of empty quotes, and a space—for example, START "" "C:\Ordered Launch\First Program.lnk".

Double-click the batch file to test it. The programs will start in the specified order, but if one takes longer to initialize, it may show up out of order. In that case, insert a delay line after the slow-starting program. This line will insert a 5-second delay: ping -n 5 127.0.0.1 > nul. Edit the number after -n to set a different delay. After testing, use the right mouse button to drag the batch file to the Start menu's Startup folder, selecting Create Shortcut(s) Here.
Remove Components Not in Add/Remove
You can uninstall many Windows components, from Solitaire to Networking Services, using the Add or Remove Programs applet from the Control Panel. Launch it and click the Add/Remove Windows Com-ponents button at left. MSN Messenger, however, is deliberately hidden, as are several other components. Here's how you tell Windows not to hide those components.

In Windows Explorer, navigate to C:\Windows\Inf and make a copy of the file Sysoc.inf. When you double-click on Sysoc.inf, it will launch in Notepad. Press Ctrl-H and replace the string ,hide, with ,, and save the file. Now you'll find that all the hidden components appear in Add/ Remove Windows Components.
Recover a Corrupted System File
If an essential Windows file goes missing, gets whacked by a virus, or is otherwise corrupted, you can restore it from your Windows XP CD. Select Search from the Start menu and search the CD for the filename, replacing the last character with an underscore—for example, Notepad.ex_. If it's found, open a command prompt and enter the command expand followed by the full pathname of the file and of the desired destination, for example, expand D:\Setup\Notepad.ex_ C:\Windows\Notepad
.exe. If either pathname contains any spaces, surround it—the full path—with double quotes.

If the file isn't found, search again using the unmodified filename. It will probably be inside a CAB file, which XP treats as a folder. Then simply open the folder, drag the file to the desired location while holding down the right mouse button, and choose Copy Here.
Make a Recovery Disc
Your PC may have come with a recovery CD that will restore it to the precise state—as far as OS, drivers, and software are concerned—it was in when you bought it. But really, the older your system is, the less useful that CD is. It will lack all the latest security patches (including Windows XP Service Pack 2) and in all likelihood, many drivers will be outdated. So it's an excellent idea to build a new recovery CD, and fortunately you can. The process is more involved than will fit here, so for our full instructions, point your browser to http://go.pcmag.com/xpsp2recover .
Reboot to Safe Mode in Win XP
Sometimes in the course of troubleshooting you need to reboot and start Windows in Safe Mode, which is a minimal start-up that loads only those Windows components that are absolutely essential. In theory, you can enter Safe Mode by restarting and then either holding down the Ctrl key or pressing the F8 key at the right moment. In practice, it can be difficult or, with a USB keyboard, impossible (the USB drivers aren't available in the DOS start-up environment). To configure Windows XP so its next restart will enter Safe Mode, launch the System Configuration Utility (msconfig) from the Start menu's Run dialog. Click the BOOT.INI tab and check the box titled /SAFEBOOT. Don't touch the other settings. When you reboot, XP will start in Safe Mode and will keep doing so until you uncheck that box.

Task Manager Missing Parts
Normally, the Windows XP Task Manager contains several tabs with information and options for Applications, Processes, Performance, and Networking. But sometimes the Task Manager goes wonky, displaying just one tab and no menu. This is the Task Manager's "tiny footprint" mode, invoked by double-clicking on the border around the tabs. It's easy to do this accidentally. Fortunately, it's just as easy to restore Task Manager to normal: Simply double-click in the border of the window again.

Restore the Show Desktop Icon
If we had a nickel for every time we've been asked how to restore this handy Quick Launch icon . . . well, we'd have a few bucks by now. The Show Desktop icon isn't a normal shortcut. If you accidentally delete it, restore it like so: Launch Notepad and type these lines:

[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop
Save the file with the name "Show Desktop.scf", including the quotes, to the folder C:\Documents and Settings\username\Application Data\Microsoft\Internet Explorer\Quick Launch, where username is replaced by your actual user account name.

Shortcut to Shutdown
We've all noted the irony of having to click on Start to shut down. But you can create a shortcut that will automatically shut down your PC, log you off, or reboot.

Right-click on the desktop and choose New | Shortcut. Browse to the file C:\Windows\System32\Shutdown.exe, click Next, name the shortcut, and click Finish. Now right-click on the new shortcut and choose Properties. In the Target box, append the command line switch -l (to log off), -s (to shut down), or -r (to reboot).

If you also add the switch –t xx (where xx is a number of seconds), Shutdown.exe will display a warning and countdown before activating. You can specify a comment to be displayed with the warning by adding the switch -c "Your text". The countdown behavior is particularly useful if the shutdown is launched through the Scheduled Tasks applet. Once it's activated, the only way to stop the program is to launch it again with the -a (for abort) switch on its command line—you might create a separate Cancel Shutdown shortcut for that.

Edit the Registry Safely
ARTICLE DATE:  06.01.05
By  Neil J. Rubenking 

Some of the tips in our collection require editing the Registry. Before making any such changes, you should back up the current Registry data. This doesn't mean using the Windows XP Backup applet or even saving a system restore point. Rather, use the Registry Editor itself to back up the Registry keys that will be changed.

To begin, select Run from the Start menu and enter regedit to launch the Registry Editor. Navigate to the key you're going to edit and select Export from the File menu. Don't set the Export Range to All—that would back up the entire Registry, and restoring such a backup would wipe out all later changes. Instead, choose the Selected Branch option, which will back up just the selected key, with its subkeys and values. Save it to a REG file with a name that will remind you of the purpose of the change. Open the REG file in Notepad and insert a few comment lines that describe the tip (to create a comment line, put a semicolon at the start of the line). Now go ahead and make all changes to the Registry keys and values specified by the tip you're applying. Any time you add a new key or value, make a note of it with another comment line in the REG file. When you're done, save the REG file and close Notepad.

If it's necessary to undo the Registry tweak, start by double-clicking the REG file and confirming that you want to merge it into the Registry. This will restore any deleted keys or values, and will restore the original data for any changed values. Note, however, that it will not remove any keys or values that you added. To take care of those, refer to the comments you inserted in the REG file. Right-click the REG file and choose Edit, which will open the file in Notepad. Check for comments about added keys or values and, if found, use the Registry Editor to delete them. You can delete the REG file itself once you've completed the restore process.

Best of User to User: General
ARTICLE DATE:  06.01.05
By Sarah Pike 

Reader: You can force Windows XP to display the blue screen of death—the only reason to do this is, with any luck, you'll never see it otherwise! In the Registry key HKLM\System\CurrentControlSet\Services\i8042prt\Parameters, find or create a DWORD value named CrashOnCtrlScroll. Double-click it and set its data to 1. Restart the computer. Now you can cause a crash by holding the right-side Ctrl key and pressing the Scroll Lock key twice.

PC Mag: Actually, a valid reason to crash your computer is to test your recovery options. First, make sure the recovery configuration is correct: Right-click My Computer and choose Properties, then click the Advanced tab. Click the Settings button in the Startup and Recovery pane. In the System Failure pane check all three options. If you choose the 64KB Small Memory Dump, each occurrence will be written separately to the folder specified. The Kernel Memory Dump is larger, and a Complete Memory Dump requires that you have a paging file large enough to hold all physical RAM plus one megabyte—this is the largest option. By default, the two larger options are written to the file memory.dmp in the Windows folder, with each occurrence overwriting the previous one.

Once you've got the settings the way you want, close any open programs and use the key combo to crash the system. You can verify that the desired memory dump is written, and check just how long it takes to restart after a crash.

Use the Keyboard
ARTICLE DATE:  06.01.05
By Sarah Pike 

Highlight a file or folder and press Shift-Del to delete permanently, bypassing the Recycle Bin.

Alt-Enter opens the highlighted file or folder's Properties dialog.

In Windows Explorer, highlight a folder and press Shift-NumPadAsterisk to open the folder and all subfolders.

Click in Windows Explorer's details pane, then press Ctrl-NumPadPlus to size each column exactly as wide as its largest item.

The Windows key brings up the Start menu, of course; but it does quite a bit more when used in combination with other keys:

Win-D toggles between showing the desktop and restoring all windows.

Win-E invokes the Windows Explorer window.

Win-L locks your system until you enter your password—or lets you switch active users, if you're using Fast User Switching.

Win-M minimizes all windows.

Win-R brings up the Run dialog.

Win-S, in Microsoft Word 2002 or later, invokes Windows' text-to-speech engine, which will read either highlighted text or everything from the cursor on.

Win-Pause/Break brings up the System Properties dialog.

Win-U invokes the Utility Manager, which controls accessibility program options.

Missing the Windows key? Ctrl-Esc will bring up your Start menu, though it won't allow you to use Windows-key combo commands like those above.

You can create your own keyboard shortcuts to frequently used programs by right-clicking on their shortcut icons (in the Start menu or on the desktop), then clicking in the Shortcut key field and striking a key. Hey, presto, Ctrl-Alt-that key will now start the app. Don't want the Ctrl-Alt combo? You can press Ctrl-Shift-x, Shift-Alt-x, or Ctrl-Shift-Alt-x instead. A few x keys are verboten here: Esc, Enter, Tab, Space, Print Scrn, Del, and Backspace aren't allowed.

Security Tips
ARTICLE DATE:  06.01.05
By Sarah Pike 

The more prominent and irreplaceable computers become in our lives, the more the bad guys seek to compromise PCs and networks for their own nefarious purposes. Don't be a chump; learn how to protect yourself from hackers who want to control your system, steal your data or identity, or simply take you down for the fun of it.

Carry a Big Stick
Lest anyone come away from this story with the idea that you can be safe without a panoply of security products, we'll take this opportunity to remind you: Every PC needs effective and up-to-date antivirus, personal firewall, antispyware, and antispam. You'll find our latest reviews of these security utilities, alone and bundled into suites, plus loads more tips for keeping your computing on the safe side, at http://go.pcmag.com/security .
Give Windows Firewall Its Moment in the Sun
One of the first things you'll want to do with a new system is download updates to the operating system and applications, activate any security software that came with your system, and install any security software that didn't.

Hold on. To do most of this, you'll have to get online—sans adequate security. Windows XP does come with a personal firewall, although it does only half the job. Still, before you even plug in the cable that will connect your PC to the Internet, go to the Control Panel, double-click on Windows Firewall, and switch it on. Later, when you've got a full personal firewall installed and updated—along with the rest of the security canon—you'll want to disable the Windows one and simply use the Security Center to confirm that your security apps are functional and up to date.

Update Automatically
Reading about a new virus outbreak or Windows security hole every few weeks—or every few days, at times—is worrying. Keeping the operating system patched with the latest security fixes is critical. During setup of Windows XP Service Pack 2, either with a new machine or an update, you're asked whether to turn on automatic updating. If you spazzed and clicked No, find the option in Windows Security Center and make the change.

Toughen Passwords
We've said it before, and we're gonna just keep on saying it: Any word in the dictionary is not a strong password, no matter how many syllables it has. A password should consist of at least eight characters, including letters, numbers, and symbols. We urge you to check out our story on password crackers (go.pcmag.com/passwords)—these clever little programs aren't getting any slower. You may also want to consider long, easy-to-remember passphrases instead—see http://go.pcmag.com/passphrase for more on this.

Lock Your Windows
Get in the habit of locking your system before you walk away. It couldn't be easier: Just press the Windows key plus the L key and the system will immediately lock, requiring your log-on password (or an administrator's) to function again.

If your keyboard is missing the Windows key (IBM PCs, for example, lack them), pressing Ctrl-Alt-Del, then Enter, will accomplish the same (although some will hit a snag here; for more details, see this User to User tip).

Use Wpa for Wireless Network Security—Or Make the Best of Wep
We recommend using WPA-ready wireless equipment, but many of us are stuck with WEP-only wireless cards or access points. Neither security protocol is particularly intuitive to set up, but if you leave your wireless connection unsecured, the very least you can expect is a hitchhiker or two on your connection.

We've put together a comprehensive guide to setting up a WPA-encrypted connection; you'll find it at http://go.pcmag.com/wpa .

For those using WEP—which isn't weak, exactly, although it can be broken—make the best of it. As sure as any lock can be picked, someone who's determined enough will get through WEP encryption. But most people aren't determined. You want to bolster your WEP connection with as many of the following steps as your hardware will allow:

  Make sure the firmware is up to date with the latest security patches, which should be downloadable from the manufacturer's Web site. 

  Set the WEP to the highest level of encryption that both the access point and the wireless card(s) will allow. 

  Define the MAC addresses allowed: Go to each machine you want to allow on your wireless network, open a command prompt, and type ipconfig /all. Copy down the physical addresses, then use the access point's configuration options to limit connection to only these addresses. 

  Never use the default SSID, administrator password, or WEP key, and set all of these using criteria for tough passwords ("Password Dos and Don'ts," http://go.pcmag.com/passworddosanddonts ). 

  Disable SSID broadcasting. 

Be Spyware-Aware
Spyware is like the common cold. You didn't do anything risky—it seems as if you must've gotten it by touching a doorknob or something similarly innocuous. Your system starts to drag a little, and then a lot… and then things start getting weird, with loads of pop-ups, maybe a changed browser home page. Of course, your immune system will wipe out your cold eventually, whereas spyware tends to get worse and worse, often inviting its spyware buddies to little parasite parties on your system.

So, how do you pick up spyware? About as easily as a cold—all you have to do is browse the Web for a while. Not all freeware is really free—in some cases, you pay by getting spyware along with it. If you use a peer-to-peer file-sharing program, you almost certainly have spyware, either directly bundled with the sharing program or from an infected fellow file sharer.

There are steps you can take to minimize your risks, but we recommend purchasing a good antispyware utility and keeping it up to date (for reviews of antispyware utilities, visit http://go.pcmag.com/security ) and following safe computing practices:

  Don't take candy from strangers: If you didn't specifically request a download, don't click on the OK button to tell your browser that you want the download. 

  If it's spam, don't click: It won't enhance your love life or your hairline, but it may load malicious code on your system. 

  Don't invite anyone in: Set Internet Explorer to prompt you when sites attempt to push ActiveX controls onto your machine—and to reject unsigned ActiveX controls automatically (Tools | Internet Options | Security | Custom Settings). 

  Don't give it all up: If you must use a file-sharing app, at least set it not to share your entire hard drive. In fact, consider keeping any files you might want to share in one specific folder, and then setting the app to share only that folder. At the very least, exclude all system folders (anything within C:\Windows) from sharing. 

Best of User to User: Security
ARTICLE DATE:  06.01.05
By Sarah Pike 

Reader: I keep my system pretty well locked down, with a strong Windows log-on password and personal firewall, but occasionally I work with sensitive information and want to add an extra layer of security. How can I encrypt individual files or folders?

PC MAG: In Windows XP Pro, right-click the file and choose Properties. Click the Advanced button in the Attributes area of the General tab. Check the box titled Encrypt contents to secure data and click OK, then OK again. You won't notice a difference, but any other logged-on user will be unable to view the file. Note, though, that unless you go through a complex process to export your account's digital certificate and private key information, you too will be unable to access the files if you lose access to your account by, for example, reinstalling Windows.

Another option, available in Windows XP Home as well as Pro, is to encrypt a compressed folder. Right-click the file and choose Send To | Compressed (zipped) Folder. Open the resulting folder and choose Add a Password from the File menu.

Best of User to User: Security
ARTICLE DATE:  06.01.05
By Sarah Pike 

PC MAG: When we noticed that the familiar Ctrl-Alt-Del followed by Enter no longer worked to lock our computers, we offered a workaround—and then quite a few readers wrote in, puzzled because they found the key combination still worked for them just as it did under Windows 2000. Why would it work on some systems and not others? The difference turned out to involve the use of the Welcome screen. If you configure Windows XP to use the Welcome screen, Ctrl-Alt-Del brings up the Task Manager. If you configure it to log on using the Windows 2000 style, Ctrl-Alt-Del brings up Windows Security, and pressing Enter at that point locks the computer.

To enable or disable the Welcome screen, launch the User Accounts applet from the Control Panel and click the link Change the way users log on or off. The box titled Use the welcome screen for fast and easy logon controls whether the Welcome screen is displayed.

Customization
ARTICLE DATE:  06.01.05
By Sarah Pike 

A great many of Windows' settings can be tweaked to reflect your computing preferences in more relevant ways than, for example, changing the picture on the desktop.

Edit the Send To Menu
When you right-click on a file and choose Send To, a submenu appears with options to copy that file to the A: drive, the My Documents folder, or various other places. You can enhance this menu to copy files into the folder of your choice. Navigate to the folder C:\Documents and Settings\username\SendTo (replacing username with your username). If the SendTo folder isn't visible, select Folder Options from the Tools menu, click on the View tab, and check the box labeled Show hidden files and folders. Launch another instance of Windows Explorer and locate the desired destination folder. Right-drag it into the SendTo folder and choose Create Shortcut(s) Here. Rename the new shortcut with the name you want to see in the Send To menu.

Edit the Places Bar
The Open and Save dialogs have a Places Bar at left with five buttons for folders like My Documents. You can actually replace one or more of these with your own choice of folder. The easiest way is to use the TweakUI PowerToy, a free download available at www.microsoft.com/windowsxp/ pro/downloads/powertoys.asp. Launch it and click Common Dialogs in the list at left, then the Places Bar. Check the option titled Custom places bar. Now you can choose any of 11 system folders for each of the buttons, or type in a folder of your choice.

It's also possible to change the folders by tweaking values in the Registry key HKCU\ Software\Microsoft\Windows\Current Version\Policies\comdlg32\placesbar. Each of the values named Place0 through Place4 holds either a numeric value representing one of the system folders or a string value representing a user-defined folder. To change from system to user-defined, you'll have to delete the numeric value and create a string value with the same name. Clearly, using TweakUI is a much easier solution.

Unwanted Network Neighbors
If you ever have to navigate to My Network Places, you've likely been hung up by the long list of network nodes. These nodes are folder shortcuts, created automatically by the system. They may even be shortcuts to network shares that no longer exist. You should be able to delete them without harm.

Before deleting one, however, right-click it, choose Properties, and verify that the Type field says Folder Shortcut. If so, go ahead and delete it. You can still access any node on the network through the Entire Network node or the Computers Near Me node. When you do, Windows will recreate the folder shortcut.

Don't Wait for a Welcome
Tired of the extra step the Windows XP Welcome screen represents? We don't recommend it, but you can make Windows XP boot directly into your main user account, bypassing the Welcome screen. It requires these precise conditions: exactly one user account, not password- protected, and no Guest account. But even if these criteria seem true, you may find that suddenly one day the Welcome screen starts appearing at start-up. This generally happens because of a Windows Update that adds a virtual user account called ASP .NET. This account is useful only to programmers—if you don't need the account, you can delete it from the Control Panel's User Accounts applet. Of course, the next Windows Update may well restore that account. And it's a really bad idea to configure your user account with no password.

Don't Wait for a Welcome: Multiuser Edition
You may want to boot directly to the default account, bypassing the Welcome screen, on a computer that has multiple user accounts defined. Select Run from the Start menu and enter control userpasswords2 to launch the User Accounts applet. Uncheck the box at the top whose title begins Users must enter a user name. (Note that if your computer is connected to a domain this box won't appear, and this solution does not apply.) Click OK and enter your username and password in the Automatically Log On dialog that appears. Click OK once more. Windows should now boot to the default account without requiring a password.

Whichever technique you used to bypass the Welcome screen, you won't lose access to the other user accounts. If you hold down the Shift key while Windows is starting, the Welcome screen will appear. You can also choose Log Off from the Start menu and then log on as another user.

No matter how you accomplish it, configuring Windows XP to boot without going through the Welcome screen leaves your system wide open to anybody with physical access to it. Unless the system in question is locked in a safe when not in use, you may be better off suffering through the drudgery of entering a password at start-up.

Best of User to User: Customization
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Reader: How can I make the Shift key turn off Caps Lock in Windows XP, the way it does on a typewriter?

PC Mag: Launch the Regional and Language Options applet from the Control Panel, click the Languages tab, then click the Details button. If the button called Key Settings is grayed out, click the Add button and add another keyboard definition, for example United States-International. Select the keyboard you normally use and click the Key Settings button. In the panel titled To turn off Caps Lock, select Press the SHIFT key. Click OK, OK, OK. Now you will turn off Caps Lock only by pressing one of the Shift keys—a second press of Caps Lock no longer turns it off.

Multiuser & Networks
ARTICLE DATE:  06.01.05
By Sarah Pike 

When several people regularly use one computer, they'll probably want to set up multiple profiles to keep everyone's preferences straight, including bookmarks, screen settings, and My Documents folders. And when several people in the same house use their own computers, they'll probably end up networking the machines. Whether you're sharing one PC or connecting several, these tips will help you coexist peaceably.

Switch Users—Fast
It takes at least a few tedious seconds to log one user off and another one on. Windows XP has an option to speed that up: Fast User Switching (FUS) lets you switch without logging off. To enable it, open User Accounts in the Control Panel, click on Change the way users log on or off, and check the Use Fast User Switching box. Now, when you select Log Off, a Switch User option appears that lets you quickly change to another account without making any users close their programs. When FUS is enabled, holding down the Windows key and typing the letter L zips you to the Welcome screen.

Beware of the trade-offs of Fast User Switching, though. You should avoid running system-level utilities, such as defraggers or indexing utilities, when another user is logged on, and if you're looking for the best performance, you don't want to let idle accounts in the background tie up system resources. The feature is best for those times when you simply need to get in and out quickly. Also note that Fast User Switching does not work if your computer is a member of a network domain.

Limit Access to the Task Manager
To prevent users from killing important processes like antivirus scanning or usage monitoring, you can use the Group Policy Editor to disable the Task Manager. Log on as an administrator and launch Gpedit.msc using the Start menu's Run dialog. Navigate to User Configuration\Administrative Templates\System\Ctrl-Alt-Del Options. In the right-hand pane, double-click on Remove Task Manager and change its status to Enabled. You can still launch the Task Manager by right-clicking on C:\Windows\ System32\TaskMgr.exe, choosing Run As…, and using the Administrator password.

This works in Windows XP Pro; to accomplish something similar in Windows XP Home, which lacks the Group Policy Editor, log on to each user account and edit the Registry. In HKCU\Software\ Microsoft\Windows\CurrenTVersion\Policies\System, create a DWORD value named DisableTaskMgr, and set its data to 1. Do the same in the key HKEY_USERS\ Default\Software\Microsoft\Windows\CurrenTVersion\Policies\System.

Network Multiple PCS
If instead of multiple users using one machine you've got several PCs in one dwelling, you'll probably end up networking them, even if only to share an Internet connection. And guess what? Windows has networking set-up and troubleshooting tools. They're in the Control Panel's Network Connections applet. Select Set up a home or small office network and Windows will walk you through network configuration, helping you choose sensible settings.

If you're trying to fix an existing network, try the Network Troubleshooter in Windows Help and Support. It's surprisingly effective.

Troubleshoot Your Network
When you encounter a network problem, some of these command line tools can help you narrow down the source. From the command prompt:

  ping ipaddress (for example, ping 192.168.0.1) shows whether your PC can contact another computer or network device at a specific IP address. First ping your router to see if your LAN is working, then ping something on the Internet to see if the problem is outside. 

  tracert ip address (for example, tracert 192.168.0.101) reveals every router hop from your PC to another computer or network device. If you start seeing dropped responses, you may be able to tell whether the problem is local. 

  ipconfig /all shows all your computer's IP-related settings. If your PC is having trouble getting online, try ipconfig/renew to refresh your IP address or get a new one. 

  netstat gives you a list of all the active TCP/IP ports on your system—very useful in detecting whether a Trojan horse has commandeered your system. 

Best of User to User: Multiuser & Networks
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Reader: On my machine running Windows XP Pro, when I did a Fast User Switch, my dial-up Internet connection would disconnect. I found a fix for the problem. It turns out that the Internet Connection Sharing option works even for multiple users on the same computer. Here's how to set it up: From the Control Panel, launch Network Connections. Select the connection you want to share and click Change settings of this connection in the bar at left. On the Advanced tab, check the boxes Allow other network users to connect through this computer's Internet connection and Establish a dial-up connection whenever a computer on my network attempts to access the Internet. Now the connection will stay open through a Fast User Switch.

PC Mag: Microsoft's documentation verifies this. Always-on connections are unaffected by Fast User Switching. Dial-up connections will indeed be terminated unless Internet Connection Sharing is used. Other user-initiated connections, such as VPN connections, remain active while the Welcome screen is displayed. These will generally disconnect when a different user logs on, but may not do so in every case. If security is an issue, log out of any sensitive connections before allowing a Fast User Switch.

On-The-Go Tips
ARTICLE DATE:  06.01.05
By Sarah Pike 

When it comes to computers, it's all about power, and notebook computers are no exception—it's just that power has a few more meanings on these PCs.

Set Power Options
On a desktop, power options are about convenience—how long should the system idle before starting the screen saver?—but they have a much more profound effect on laptops, namely on battery longevity.

You'll find Power Options in the Control Panel, and within it, several mobile-use–specific battery options, including Portable/Laptop, Super Power Saver, and Max. Battery. You can tweak these settings beyond the presets to determine how long the system waits to turn off monitors and hard drives, and when to stand by or hibernate (depending on whether it's plugged in or on battery power).

Use External Monitors
Laptop screens, especially on small, thin-and-light notebooks, can cause eyestrain with all-day, every-day use. You may want to connect a second monitor to your laptop to use instead of, or in conjunction with, the LCD screen that's already on the machine. As long as the graphics card can handle it—most laptops' can—Windows will make it very easy for you.

To start, plug the second monitor into the laptop's output port or docking station. Then find the hot key to send what's on screen to the external monitor. Depending on the notebook, pressing the hot key (typically, Fn plus an F-key) will either page through configurations much as Alt-Tab pages through your open windows, or simply activate the configurations, blanking the notebook display and activating the external monitor, then activating both.

You can also use the external display in concert with the internal display to extend your viewable display area. Right-click on the desktop and select Properties, then choose the Settings tab. You'll see both monitors represented in the dialog box. If the second monitor is grayed out, right click on it and select Attached. Set the screen resolution and color quality for this second display. Windows generally assumes that the external display is to the right, but if it's on the other side, just drag the on-screen representation to match your layout.

With that monitor still selected, make sure there's a check in the box labeled Extend my Windows desktop onto this monitor. Choose Apply and your desktop will take advantage of the additional screen space. It's that simple. You can now drag applications back and forth between the two displays.

Split the Difference Between Standby and Powering Down
When you go through a normal shutdown (clicking on Start then Shut Down), you're given a set of options, including Shut down, Restart, Stand by, and, if you've enabled it on your Win XP system, Hibernate. Hibernation saves the current state of your system to disk, so the system can completely power down but be restored to the same state when restarted. The battery doesn't drain in this state, but restarting won't be as quick as from Standby mode.

If the Hibernate option doesn't appear in your shutdown options, launch Power Options from the Control Panel, click on the Hibernate tab, and check the box labeled Enable hibernation.
Go Straight to Hibernate
We told you in the General Tips section how to create a shortcut to shut down your Windows system automatically. But you can create a simple command-based shortcut to do the job. Right-click on the desktop and select New | Shortcut. Type this case-sensitive command into the dialog box: rundll32.exe PowrProf.dll, Set
SuspendState.
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Reader: I just bought a laptop that's supposed to run at 2.4 GHz, but when I checked the System Properties, the dialog indicated that it was a 2.4-GHz CPU and then said 957 MHz. I checked on several other computers. The same thing happened, though the speeds varied. One, for example, showed that it was a 2.4-GHz machine but running at 1.6 GHz. What's going on?

PC Mag: It's all about conserving battery life. Both mobile Pentium and mobile Athlon processors have power-saving capabilities that reduce the CPU's voltage and clock speed when running on battery power. And notebook vendors may customize these low-power settings to clock down the CPU to even lower voltages and CPU speeds.

For CPUs that support dynamically lowering speed and voltage on battery power, the power-management settings (Control Panel\Power Options) you choose will affect the processor speed. You can play around with these settings while on battery power to see whether they affect your CPU speed. Even on AC power, a CPU won't always run at its highest speed unless power management is set to Home/Office, Desktop, or Always On.
If your machine offers custom settings, your user guide should have specifics on what they do and how to set them. You can create a custom profile to fit your needs, but start with the Windows XP defaults and then vary them, so you know what effect each will have on the clock speed.

Internet Explorer
ARTICLE DATE:  06.01.05
By Sarah Pike 

The world's most prevalent browser can generally be operated without much thought. It likes to remember your passwords and type ahead for you, assuming you'll retype the same terms and URLs over and over. And it particularly likes staying installed, even going so far as to be unremovable.

Manage Saved Passwords
When you enter a Web site username and password in Internet Explorer, it may ask if you want it to remember the password. If you click Yes, it will store the password and automatically add it the next time you enter the username. But if you check Don't offer to remember any more passwords, then it won't offer to help in the future, whether you click Yes or No.

To recover this feature, launch Internet Options from IE's Tools menu, click the Content tab, click the AutoComplete button, and check the Prompt me to save passwords box. But pause before you do so—if the machine is not physically secure, you may want to uncheck the User names and passwords in forms box and click the Clear Passwords button to remove the stored passwords instead. For more sophisticated password and form management, see our reviews of form fillers and password managers, at http://go.pcmag.com/utilityguide .
Delete Items From Autocomplete Lists
When you start typing in a Web form, you may see a list of things you typed before—some of which may be private, inappropriate for work or family, or simply typed incorrectly. You can lose this baggage easily. While you're in the text box, use the down arrow (not the mouse) to scroll down and select that item. Then press the Del key to get rid of it. You can see all AutoComplete entries for a form field by clicking in the blank field and pressing the down arrow.

Pump Up the Address Bar Text
High-res screens are great—they fit much more information into the same amount of space—but when your display is set to a high resolution, reading the text in IE's Address Bar may be difficult. Here's the trick: The Address Bar uses the same font as the icon titles on the desktop. You can change these through Display Properties.

Right-click on the desktop, choose Properties, then click to the Appearance tab. Click on the Advanced button. In the pull-down Item list that appears, select Icon. Choose a more readable font and click on Apply. If the icon titles are now truncated, you can change Icon Spacing (Horizontal) and Icon Spacing (Vertical) to larger values.

Share IE Favorites
On multiuser machines, you may want to make all user accounts share the same bookmarks, so that any added bookmarks propagate to all users. To accomplish this, you'll have to tweak the Registry. First, select File | Import and Export and export your Favorites to a file. Then log on as each user and navigate to the Registry key HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrenTVersion\Explorer\User Shell Folders.

Locate the value named Favorites and change its data from the default of %USER
PROFILE%\Favorites to %ALLUSERSPROFILE%\Favorites. Then import the saved Favorites into any user account.

Cure IE's Window-Size Amnesia
It's a small problem but an annoying one: You may find Internet Explorer suddenly opening links in small windows. You can reset this easily.

Simply close all Internet Explorer windows. Open just one and Shift-click a link within it to open a secondary window. Adjust the secondary window to the size you want for all secondary windows. Then close it by holding Shift while clicking the X icon at top right. Size the primary window and close it in the same way. You may need to repeat this process if IE forgets after a while. Note that you can do the same for Windows Explorer, omitting the secondary window.

Block Internet Options
Unscrupulous Web sites or malicious programs can hijack your Internet Explorer home page, causing IE to start at a (usually) sleazy page. Anybody with access to your computer can do the same, or change other important settings. This dual Registry tweak offers some defense against unauthorized changes to your IE settings. Navigate to HKCU\Software\Policies\Microsoft\Internet Explorer\Restrictions and find or create a DWORD value named NoBrowserOptions. Double-click it and set its data to 1.

Now switch to the neighboring key HKCU\Software\Policies\Microsoft\Internet Explorer\Control Panel. Find or create a DWORD value named HomePage, and again set its data to 1. If you want to use Internet Options or change the home page yourself, you will need to change those two values temporarily to 0. Users of Spybot Search & Destroy, take note: "Immunize" options in this program set these values automatically.

Clean Up the Right-Click Menu
Internet Explorer's right-click context menu may contain items you don't need or ones that point to nonexistent programs. You can use the Registry Editor (regedit from Start | Run) to remove unwanted items from this menu.

In the Registry Editor, navigate to HKCU\ Software\Microsoft\Internet Explorer\MenuExt. You'll see a number of subkeys, each of which represents one of IE's context menu items. Simply select and delete any you don't want to see anymore.

Best of User to User: Internet Explorer
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Reader: In Windows XP, Internet Explorer 6, I need to restrict the browser to one specific domain, so the user can browse only to pages in this domain.

PC Mag: This can be done without third-party software. Browsers and other programs check the Hosts file to resolve domain names into IP addresses before they attempt to get the same information from a DNS server. If you disable DNS lookup, the Hosts file becomes a whitelist—only domains listed there will be accessible.

Open C:\Windows\System32\drivers\etc\Hosts in Notepad. Open a command prompt window and enter ping followed by the domain name you want to check, for example, ping www.ucdavis.edu. Append a line to the Hosts file consisting of the IP address revealed by the ping, a space, and the domain name, for instance, 169.237.104.199 www.ucdavis.edu . Add any more domains you want to allow (the POP3 or SMTP addresses used to access e-mail, for example). Save the Hosts file and close Notepad.

Launch Network and Dial-up Connections from the Control Panel, right-click the connection through which you access the Internet, and select Properties. Select TCP/IP in the components list and click the Properties button. On the General tab, note any existing DNS numbers and store them somewhere safe. Those numbers will be essential if you want to undo this modification. Check the box Use the following DNS connections and enter invalid DNS lookup addresses for Preferred DNS Server and Alternate DNS server—you can use 1.0.0.0 and 1.0.0.1. Restart the system. Any program that attempts to access a domain not listed in the Hosts file will fail. Truly determined users can log on to a "blocked" domain by entering its IP address instead of the domain name (though they won't be able to follow links). Still, this is a free solution and can be quite effective.

Best of User to User: Internet Explorer
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Reader: Is there any way to remove the saved username and password from a single Web site and keep all of my other saved password data? IE offers only to clear all the passwords from all sites.

PC Mag: To remove a stored username/password for a particular site, first navigate to the site. When Windows prompts you for the username and password, click in the username box and press the down arrow. This will show all the usernames stored for this particular site (usually just one). Press the down arrow until the name to be removed is highlighted and then press the Del key. Internet Explorer will ask whether you want to delete the username and password information. Click Yes and it's gone.

Mozilla Firefox
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By Sarah Pike 

Since the Mozilla Organization aimed its powerful weapon, the Firefox Web browser, at Microsoft, it has been gaining an ever-growing stake in the online market. Firefox's biggest gun is its customizability. Whether you are switching over for the first time, or are a seasoned user, here are some tips to enhance your browsing experience.

Import Away!
If you're changing browsers, or if you simply like having more than one on your system, there's an easy way to pull your other browsers' settings into Firefox. When you use the program's handy import tool, Firefox will grab the options, bookmarks, history, passwords, and other data from browsers like Internet Explorer, Netscape, and Opera. It's a real time-saver.

The Import function pops up during the initial installation of Firefox. Pick the browser you want to import your settings from, select what settings you want to import, and that's it. You're done. If you skipped this step when you first installed Firefox, just choose the Import function from the File menu.

But if you truly want to capture the fresh-from-scratch experience of switching browsers, you may want to uncheck the Cookies, Browsing History, Saved Form History, and Saved Passwords. Internet Options and Favorites are helpful to have when starting out, but this might be a good opportunity to do some spring cleaning of your stale old saved information.

Squint to Update
Unlike IE, Firefox won't update itself automatically when security patches are available. But updating the browser is a snap—once you realize an update is ready and waiting. Unfortunately, the diminutive upgrade notification icon is located inconspicuously in the upper right corner of the Firefox window. If any critical updates are available, the button looks like a white arrow on top of a red circle (the notification for updates to your extensions is blue). Click it and Firefox will begin the upgrade process. If there aren't any upgrades for anything you're running, said button will be barely noticeably absent.

Clicking on the easy-to-miss gray circle next to the upgrade button will take you to the Firefox home page, or Firefox Central. From there, you can take the initiative and personally update your browser with all the latest plug-ins, extensions, and themes; you can also check via the Tools menu—it's under Options | Advanced | Software Update.
You can also update your extensions and themes from their respective management windows. Click the Tools menu, then Extensions or Themes. From there, you can see a list of all the extensions and themes you have installed and individually check each one for updates.

Open Multiple Home Pages
You can take advantage of Firefox's tabbed interface right from the get-go, setting it to open multiple, tabbed pages on start-up—a handy tool for anyone who likes to sign on to a few favorite Web sites every day. Click on Tools | Options and the first thing you see should be the line for home page location.

Click in the text field, and type in the page you want Firefox to load first on the leftmost tab. After the address, insert a vertical bar (|) and type the next address. It's as easy as that. And there appears to be no limit to the number of pages you can designate to open; we got to 47 before our annoyance at the massive number of open tabs caused us to stop.

There's an even easier way to set up multiple home pages. When you're in Firefox, open all the tabbed pages you want to see on the browser's start-up. Go to Tools | Options again. Underneath the home page location bar is a button marked Use Current Pages. Click that and Firefox will automatically make all the currently open tabs your home pages.

Better Bookmarks
Whether you have three bookmarks or hundreds of them, Firefox has a few features that will ease your bookmarking experience. The newest version of the browser has simplified the processes for grouping bookmarks and opening multiple bookmarked pages. Now to open an entire folder's contents in tabs at once, just click on the Bookmarks menu, right-click on the desired folder, and select Open in Tabs.
Conversely, to save all of your open tabs at once, just click on the Bookmark menu and select Bookmark This Page. Though the window that pops up will prompt you for a name for the single bookmark, just pretend it's asking you for a folder name. Type that in, select the Bookmarks folder for a location, and make sure you click Bookmark all tabs in a folder. A new folder will appear in your Bookmarks menu containing all the tabs currently open in your browser. You can later go back and edit the properties of each bookmark, adding a short description to enhance your memory of just what each site was.

Use Keywords to Nickname Bookmarks
Another neat bookmark-related feature of Firefox is its ability to assign keywords to bookmarks. For example, you might assign the keyword ultrasweet to your www.pcmag.com bookmark.

It's a simple process. Click on the Bookmarks menu, right-click on a bookmark, and select Properties. In the Keyword field, enter the word of your choice. You can now use that word in place of the site's full URL in the address bar, and you'll be taken right to the page you saved.

Keywords II: but Wait, There's More
For certain search-based Web sites—Google, for example—you can actually use keywords to search straight from your address bar. For example, when you query Google normally, you're accessing the URL http://google.com/search?q=, where anything after the q= is the exact text you're searching for. Try adding that URL to your bookmarks folder, but modify it to read http://google.com/search?q=%s and assign it the keyword google. You can now type google x into your browser, where x is any search term you want to look up, like computers. You'll go directly to the results page, having saved a few steps in the process. This trick works for a lot of searchable Web sites; play around with it.

Be the Boss of Your Tabs
The uninitiated should know: Tabbed browsing quickly becomes a browsing requirement. It's just too convenient to give up. One common peeve of newbies, though, is that clicking on an external link, for example in an e-mail message, opens the link in the active tab, replacing the page you were on. Tabbed browsing was supposed to take care of that, right? It does. You just have to find the Tabbed Browsing options: Tools | Options | Advanced. You can elect to have external links open in a new window, in a new tab, or in the active tab. To open links from Web pages or bookmarks in new tabs, simply right-click on the links and select Open Link in New Tab.
Learn About About:Config
To peer into the brains of the Firefox browser, type about:config into the address bar and hit Enter. What follows is a large listing of the browser's internal configuration options, nearly all of which will make little sense to the average user. Luckily, Mozilla's all about online help, tutorials, and forums. We find http://kb.mozillazine.org/About:config particularly helpful—check the References links for more details than you can shake a stick at.

Speed It Up a Notch
One easy, cool preference you might want to tweak deals with speed. By default, Firefox runs fast enough—it's like driving at the speed limit. But if you want to push your browsing experience, modify a few settings in about:config. Note that these edits are for broadband connections only; if you're still dialing up, you're stuck with whatever speed you've got.

On the about:config screen, scroll down to the network.http.pipelining options. The name says it all: Firefox normally processes all HTTP requests sequentially. Once it sends one out, it waits for a response before sending the next request to a server. If you set network.http.pipelining and network.http .proxy.pipelining to true then you've basically just upgraded an antiquated browsing system with modern plumbing. Set the network.http.pipelining.maxrequests option to 30 and Firefox will now send up to 30 HTTP requests at once—theoretically, although not always, making your browsing that little bit faster.

Before you close the window, right-click anywhere on the about:config page and select New | Integer. Then type in nglayout.initialpaint.delay and enter 0 as its value. Firefox will now render pages immediately instead of waiting its default 250 ms, a slight but noticeable difference when you're surfing the Web.

Feed Me
RSS readers are quickly becoming the best tools for staying up to date with the latest postings on your favorite Web sites and blogs. (You can subscribe to PC Magazine's RSS feeds at http://go.pcmag.com/rss .) Mozilla built a full RSS reader into its Thunderbird mail client, but Firefox can make use of RSS as well.

You may have noticed a button called Latest Headlines on Firefox's Bookmarks toolbar. When you click on the button, you're presented with a dynamically generated list of links to current news stories. This is what Firefox calls a Live Bookmark, and it's generated by an RSS feed. You can click through to any link on the list, or open every item all at once.

When you visit a site that has a feed, you'll see a little Live Bookmark icon in the lower right of the browser window. Click the icon and you'll see a list of all published feeds. Choose the feed you want and Firefox asks where it should store the Live Bookmark. Choose Bookmarks Toolbar Folder from the Create in drop-down menu and, voilà, a button for the feed appears on the toolbar. Now you can check for the latest news whenever you want.
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Windows XP is a take-charge kind of operating system, and it's easy to sit back and leave it to its own devices, so to speak. But from start-up to shutdown, in the face of baffling errors to programs you don't use but can't get rid of, you can be more in control than you may have thought.

Control Which Programs Launch at Start-Up
Many of the programs you install on your system automatically configure themselves to launch at start-up, often invisibly. The truly essential ones, such as firewall and antivirus products, generally run as Windows services, working efficiently in the background. Other less important products like media players really don't need to be running constantly, if at all. These extra applications slow the boot process and then suck up system resources and CPU cycles.

There are many ways a program can launch at start-up. The System Configuration Utility rounds up all of the start-up programs in a single display. Launch it by choosing Run from the Start menu and entering msconfig. The Startup tab displays a complete list of the programs that launch at start-up. To disable any one of them reversibly, just uncheck the box at left. It should be safe to disable any of them, as only nonessential programs appear on the Startup tab. But leave the adjacent Services tab alone—disable some of those entries and you may disable Windows completely.

For an even simpler approach, you might want to try a start-up manager like Absolute Startup (for our review, see http://go.pcmag.com/utilityguide ).

Control Start-Up Launch Order
Windows checks various locations in the file system and Registry to determine which programs should launch at start-up, but gives you no real control over the launch order. Here's how to enforce a specific order, perhaps to connect to a VPN before launching a program that needs that connection.

If shortcuts to the start-up programs reside in the Start menu's Startup folder, move them to a new folder; otherwise, create a shortcut to each in a new folder. Open a command prompt, navigate to that new folder, and issue the command DIR /B > ORDERED.BAT. Enter NOTEPAD ORDERED.BAT to open the resulting batch file in Notepad. Use copy-and-paste to put the lines in the desired order. Surround each line with quotes and precede it with the START command, a pair of empty quotes, and a space—for example, START "" "C:\Ordered Launch\First Program.lnk".

Double-click the batch file to test it. The programs will start in the specified order, but if one takes longer to initialize, it may show up out of order. In that case, insert a delay line after the slow-starting program. This line will insert a 5-second delay: ping -n 5 127.0.0.1 > nul. Edit the number after -n to set a different delay. After testing, use the right mouse button to drag the batch file to the Start menu's Startup folder, selecting Create Shortcut(s) Here.
Remove Components Not in Add/Remove
You can uninstall many Windows components, from Solitaire to Networking Services, using the Add or Remove Programs applet from the Control Panel. Launch it and click the Add/Remove Windows Com-ponents button at left. MSN Messenger, however, is deliberately hidden, as are several other components. Here's how you tell Windows not to hide those components.

In Windows Explorer, navigate to C:\Windows\Inf and make a copy of the file Sysoc.inf. When you double-click on Sysoc.inf, it will launch in Notepad. Press Ctrl-H and replace the string ,hide, with ,, and save the file. Now you'll find that all the hidden components appear in Add/ Remove Windows Components.
Recover a Corrupted System File
If an essential Windows file goes missing, gets whacked by a virus, or is otherwise corrupted, you can restore it from your Windows XP CD. Select Search from the Start menu and search the CD for the filename, replacing the last character with an underscore—for example, Notepad.ex_. If it's found, open a command prompt and enter the command expand followed by the full pathname of the file and of the desired destination, for example, expand D:\Setup\Notepad.ex_ C:\Windows\Notepad
.exe. If either pathname contains any spaces, surround it—the full path—with double quotes.

If the file isn't found, search again using the unmodified filename. It will probably be inside a CAB file, which XP treats as a folder. Then simply open the folder, drag the file to the desired location while holding down the right mouse button, and choose Copy Here.
Make a Recovery Disc
Your PC may have come with a recovery CD that will restore it to the precise state—as far as OS, drivers, and software are concerned—it was in when you bought it. But really, the older your system is, the less useful that CD is. It will lack all the latest security patches (including Windows XP Service Pack 2) and in all likelihood, many drivers will be outdated. So it's an excellent idea to build a new recovery CD, and fortunately you can. The process is more involved than will fit here, so for our full instructions, point your browser to http://go.pcmag.com/xpsp2recover .
Reboot to Safe Mode in Win XP
Sometimes in the course of troubleshooting you need to reboot and start Windows in Safe Mode, which is a minimal start-up that loads only those Windows components that are absolutely essential. In theory, you can enter Safe Mode by restarting and then either holding down the Ctrl key or pressing the F8 key at the right moment. In practice, it can be difficult or, with a USB keyboard, impossible (the USB drivers aren't available in the DOS start-up environment). To configure Windows XP so its next restart will enter Safe Mode, launch the System Configuration Utility (msconfig) from the Start menu's Run dialog. Click the BOOT.INI tab and check the box titled /SAFEBOOT. Don't touch the other settings. When you reboot, XP will start in Safe Mode and will keep doing so until you uncheck that box.

Task Manager Missing Parts
Normally, the Windows XP Task Manager contains several tabs with information and options for Applications, Processes, Performance, and Networking. But sometimes the Task Manager goes wonky, displaying just one tab and no menu. This is the Task Manager's "tiny footprint" mode, invoked by double-clicking on the border around the tabs. It's easy to do this accidentally. Fortunately, it's just as easy to restore Task Manager to normal: Simply double-click in the border of the window again.

Restore the Show Desktop Icon
If we had a nickel for every time we've been asked how to restore this handy Quick Launch icon . . . well, we'd have a few bucks by now. The Show Desktop icon isn't a normal shortcut. If you accidentally delete it, restore it like so: Launch Notepad and type these lines:

[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop
Save the file with the name "Show Desktop.scf", including the quotes, to the folder C:\Documents and Settings\username\Application Data\Microsoft\Internet Explorer\Quick Launch, where username is replaced by your actual user account name.

Shortcut to Shutdown
We've all noted the irony of having to click on Start to shut down. But you can create a shortcut that will automatically shut down your PC, log you off, or reboot.

Right-click on the desktop and choose New | Shortcut. Browse to the file C:\Windows\System32\Shutdown.exe, click Next, name the shortcut, and click Finish. Now right-click on the new shortcut and choose Properties. In the Target box, append the command line switch -l (to log off), -s (to shut down), or -r (to reboot).

If you also add the switch –t xx (where xx is a number of seconds), Shutdown.exe will display a warning and countdown before activating. You can specify a comment to be displayed with the warning by adding the switch -c "Your text". The countdown behavior is particularly useful if the shutdown is launched through the Scheduled Tasks applet. Once it's activated, the only way to stop the program is to launch it again with the -a (for abort) switch on its command line—you might create a separate Cancel Shutdown shortcut for that.

Edit the Registry Safely
ARTICLE DATE:  06.01.05
By  Neil J. Rubenking 

Some of the tips in our collection require editing the Registry. Before making any such changes, you should back up the current Registry data. This doesn't mean using the Windows XP Backup applet or even saving a system restore point. Rather, use the Registry Editor itself to back up the Registry keys that will be changed.

To begin, select Run from the Start menu and enter regedit to launch the Registry Editor. Navigate to the key you're going to edit and select Export from the File menu. Don't set the Export Range to All—that would back up the entire Registry, and restoring such a backup would wipe out all later changes. Instead, choose the Selected Branch option, which will back up just the selected key, with its subkeys and values. Save it to a REG file with a name that will remind you of the purpose of the change. Open the REG file in Notepad and insert a few comment lines that describe the tip (to create a comment line, put a semicolon at the start of the line). Now go ahead and make all changes to the Registry keys and values specified by the tip you're applying. Any time you add a new key or value, make a note of it with another comment line in the REG file. When you're done, save the REG file and close Notepad.

If it's necessary to undo the Registry tweak, start by double-clicking the REG file and confirming that you want to merge it into the Registry. This will restore any deleted keys or values, and will restore the original data for any changed values. Note, however, that it will not remove any keys or values that you added. To take care of those, refer to the comments you inserted in the REG file. Right-click the REG file and choose Edit, which will open the file in Notepad. Check for comments about added keys or values and, if found, use the Registry Editor to delete them. You can delete the REG file itself once you've completed the restore process.

Best of User to User: General
ARTICLE DATE:  06.01.05
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Reader: You can force Windows XP to display the blue screen of death—the only reason to do this is, with any luck, you'll never see it otherwise! In the Registry key HKLM\System\CurrentControlSet\Services\i8042prt\Parameters, find or create a DWORD value named CrashOnCtrlScroll. Double-click it and set its data to 1. Restart the computer. Now you can cause a crash by holding the right-side Ctrl key and pressing the Scroll Lock key twice.

PC Mag: Actually, a valid reason to crash your computer is to test your recovery options. First, make sure the recovery configuration is correct: Right-click My Computer and choose Properties, then click the Advanced tab. Click the Settings button in the Startup and Recovery pane. In the System Failure pane check all three options. If you choose the 64KB Small Memory Dump, each occurrence will be written separately to the folder specified. The Kernel Memory Dump is larger, and a Complete Memory Dump requires that you have a paging file large enough to hold all physical RAM plus one megabyte—this is the largest option. By default, the two larger options are written to the file memory.dmp in the Windows folder, with each occurrence overwriting the previous one.

Once you've got the settings the way you want, close any open programs and use the key combo to crash the system. You can verify that the desired memory dump is written, and check just how long it takes to restart after a crash.

Use the Keyboard
ARTICLE DATE:  06.01.05
By Sarah Pike 

Highlight a file or folder and press Shift-Del to delete permanently, bypassing the Recycle Bin.

Alt-Enter opens the highlighted file or folder's Properties dialog.

In Windows Explorer, highlight a folder and press Shift-NumPadAsterisk to open the folder and all subfolders.

Click in Windows Explorer's details pane, then press Ctrl-NumPadPlus to size each column exactly as wide as its largest item.

The Windows key brings up the Start menu, of course; but it does quite a bit more when used in combination with other keys:

Win-D toggles between showing the desktop and restoring all windows.

Win-E invokes the Windows Explorer window.

Win-L locks your system until you enter your password—or lets you switch active users, if you're using Fast User Switching.

Win-M minimizes all windows.

Win-R brings up the Run dialog.

Win-S, in Microsoft Word 2002 or later, invokes Windows' text-to-speech engine, which will read either highlighted text or everything from the cursor on.

Win-Pause/Break brings up the System Properties dialog.

Win-U invokes the Utility Manager, which controls accessibility program options.

Missing the Windows key? Ctrl-Esc will bring up your Start menu, though it won't allow you to use Windows-key combo commands like those above.

You can create your own keyboard shortcuts to frequently used programs by right-clicking on their shortcut icons (in the Start menu or on the desktop), then clicking in the Shortcut key field and striking a key. Hey, presto, Ctrl-Alt-that key will now start the app. Don't want the Ctrl-Alt combo? You can press Ctrl-Shift-x, Shift-Alt-x, or Ctrl-Shift-Alt-x instead. A few x keys are verboten here: Esc, Enter, Tab, Space, Print Scrn, Del, and Backspace aren't allowed.

Security Tips
ARTICLE DATE:  06.01.05
By Sarah Pike 

The more prominent and irreplaceable computers become in our lives, the more the bad guys seek to compromise PCs and networks for their own nefarious purposes. Don't be a chump; learn how to protect yourself from hackers who want to control your system, steal your data or identity, or simply take you down for the fun of it.

Carry a Big Stick
Lest anyone come away from this story with the idea that you can be safe without a panoply of security products, we'll take this opportunity to remind you: Every PC needs effective and up-to-date antivirus, personal firewall, antispyware, and antispam. You'll find our latest reviews of these security utilities, alone and bundled into suites, plus loads more tips for keeping your computing on the safe side, at http://go.pcmag.com/security .
Give Windows Firewall Its Moment in the Sun
One of the first things you'll want to do with a new system is download updates to the operating system and applications, activate any security software that came with your system, and install any security software that didn't.

Hold on. To do most of this, you'll have to get online—sans adequate security. Windows XP does come with a personal firewall, although it does only half the job. Still, before you even plug in the cable that will connect your PC to the Internet, go to the Control Panel, double-click on Windows Firewall, and switch it on. Later, when you've got a full personal firewall installed and updated—along with the rest of the security canon—you'll want to disable the Windows one and simply use the Security Center to confirm that your security apps are functional and up to date.

Update Automatically
Reading about a new virus outbreak or Windows security hole every few weeks—or every few days, at times—is worrying. Keeping the operating system patched with the latest security fixes is critical. During setup of Windows XP Service Pack 2, either with a new machine or an update, you're asked whether to turn on automatic updating. If you spazzed and clicked No, find the option in Windows Security Center and make the change.

Toughen Passwords
We've said it before, and we're gonna just keep on saying it: Any word in the dictionary is not a strong password, no matter how many syllables it has. A password should consist of at least eight characters, including letters, numbers, and symbols. We urge you to check out our story on password crackers (go.pcmag.com/passwords)—these clever little programs aren't getting any slower. You may also want to consider long, easy-to-remember passphrases instead—see http://go.pcmag.com/passphrase for more on this.

Lock Your Windows
Get in the habit of locking your system before you walk away. It couldn't be easier: Just press the Windows key plus the L key and the system will immediately lock, requiring your log-on password (or an administrator's) to function again.

If your keyboard is missing the Windows key (IBM PCs, for example, lack them), pressing Ctrl-Alt-Del, then Enter, will accomplish the same (although some will hit a snag here; for more details, see this User to User tip).

Use Wpa for Wireless Network Security—Or Make the Best of Wep
We recommend using WPA-ready wireless equipment, but many of us are stuck with WEP-only wireless cards or access points. Neither security protocol is particularly intuitive to set up, but if you leave your wireless connection unsecured, the very least you can expect is a hitchhiker or two on your connection.

We've put together a comprehensive guide to setting up a WPA-encrypted connection; you'll find it at http://go.pcmag.com/wpa .

For those using WEP—which isn't weak, exactly, although it can be broken—make the best of it. As sure as any lock can be picked, someone who's determined enough will get through WEP encryption. But most people aren't determined. You want to bolster your WEP connection with as many of the following steps as your hardware will allow:

  Make sure the firmware is up to date with the latest security patches, which should be downloadable from the manufacturer's Web site. 

  Set the WEP to the highest level of encryption that both the access point and the wireless card(s) will allow. 

  Define the MAC addresses allowed: Go to each machine you want to allow on your wireless network, open a command prompt, and type ipconfig /all. Copy down the physical addresses, then use the access point's configuration options to limit connection to only these addresses. 

  Never use the default SSID, administrator password, or WEP key, and set all of these using criteria for tough passwords ("Password Dos and Don'ts," http://go.pcmag.com/passworddosanddonts ). 

  Disable SSID broadcasting. 

Be Spyware-Aware
Spyware is like the common cold. You didn't do anything risky—it seems as if you must've gotten it by touching a doorknob or something similarly innocuous. Your system starts to drag a little, and then a lot… and then things start getting weird, with loads of pop-ups, maybe a changed browser home page. Of course, your immune system will wipe out your cold eventually, whereas spyware tends to get worse and worse, often inviting its spyware buddies to little parasite parties on your system.

So, how do you pick up spyware? About as easily as a cold—all you have to do is browse the Web for a while. Not all freeware is really free—in some cases, you pay by getting spyware along with it. If you use a peer-to-peer file-sharing program, you almost certainly have spyware, either directly bundled with the sharing program or from an infected fellow file sharer.

There are steps you can take to minimize your risks, but we recommend purchasing a good antispyware utility and keeping it up to date (for reviews of antispyware utilities, visit http://go.pcmag.com/security ) and following safe computing practices:

  Don't take candy from strangers: If you didn't specifically request a download, don't click on the OK button to tell your browser that you want the download. 

  If it's spam, don't click: It won't enhance your love life or your hairline, but it may load malicious code on your system. 

  Don't invite anyone in: Set Internet Explorer to prompt you when sites attempt to push ActiveX controls onto your machine—and to reject unsigned ActiveX controls automatically (Tools | Internet Options | Security | Custom Settings). 

  Don't give it all up: If you must use a file-sharing app, at least set it not to share your entire hard drive. In fact, consider keeping any files you might want to share in one specific folder, and then setting the app to share only that folder. At the very least, exclude all system folders (anything within C:\Windows) from sharing. 

Best of User to User: Security
ARTICLE DATE:  06.01.05
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Reader: I keep my system pretty well locked down, with a strong Windows log-on password and personal firewall, but occasionally I work with sensitive information and want to add an extra layer of security. How can I encrypt individual files or folders?

PC MAG: In Windows XP Pro, right-click the file and choose Properties. Click the Advanced button in the Attributes area of the General tab. Check the box titled Encrypt contents to secure data and click OK, then OK again. You won't notice a difference, but any other logged-on user will be unable to view the file. Note, though, that unless you go through a complex process to export your account's digital certificate and private key information, you too will be unable to access the files if you lose access to your account by, for example, reinstalling Windows.

Another option, available in Windows XP Home as well as Pro, is to encrypt a compressed folder. Right-click the file and choose Send To | Compressed (zipped) Folder. Open the resulting folder and choose Add a Password from the File menu.

Best of User to User: Security
ARTICLE DATE:  06.01.05
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PC MAG: When we noticed that the familiar Ctrl-Alt-Del followed by Enter no longer worked to lock our computers, we offered a workaround—and then quite a few readers wrote in, puzzled because they found the key combination still worked for them just as it did under Windows 2000. Why would it work on some systems and not others? The difference turned out to involve the use of the Welcome screen. If you configure Windows XP to use the Welcome screen, Ctrl-Alt-Del brings up the Task Manager. If you configure it to log on using the Windows 2000 style, Ctrl-Alt-Del brings up Windows Security, and pressing Enter at that point locks the computer.

To enable or disable the Welcome screen, launch the User Accounts applet from the Control Panel and click the link Change the way users log on or off. The box titled Use the welcome screen for fast and easy logon controls whether the Welcome screen is displayed.

Customization
ARTICLE DATE:  06.01.05
By Sarah Pike 

A great many of Windows' settings can be tweaked to reflect your computing preferences in more relevant ways than, for example, changing the picture on the desktop.

Edit the Send To Menu
When you right-click on a file and choose Send To, a submenu appears with options to copy that file to the A: drive, the My Documents folder, or various other places. You can enhance this menu to copy files into the folder of your choice. Navigate to the folder C:\Documents and Settings\username\SendTo (replacing username with your username). If the SendTo folder isn't visible, select Folder Options from the Tools menu, click on the View tab, and check the box labeled Show hidden files and folders. Launch another instance of Windows Explorer and locate the desired destination folder. Right-drag it into the SendTo folder and choose Create Shortcut(s) Here. Rename the new shortcut with the name you want to see in the Send To menu.

Edit the Places Bar
The Open and Save dialogs have a Places Bar at left with five buttons for folders like My Documents. You can actually replace one or more of these with your own choice of folder. The easiest way is to use the TweakUI PowerToy, a free download available at www.microsoft.com/windowsxp/ pro/downloads/powertoys.asp. Launch it and click Common Dialogs in the list at left, then the Places Bar. Check the option titled Custom places bar. Now you can choose any of 11 system folders for each of the buttons, or type in a folder of your choice.

It's also possible to change the folders by tweaking values in the Registry key HKCU\ Software\Microsoft\Windows\Current Version\Policies\comdlg32\placesbar. Each of the values named Place0 through Place4 holds either a numeric value representing one of the system folders or a string value representing a user-defined folder. To change from system to user-defined, you'll have to delete the numeric value and create a string value with the same name. Clearly, using TweakUI is a much easier solution.

Unwanted Network Neighbors
If you ever have to navigate to My Network Places, you've likely been hung up by the long list of network nodes. These nodes are folder shortcuts, created automatically by the system. They may even be shortcuts to network shares that no longer exist. You should be able to delete them without harm.

Before deleting one, however, right-click it, choose Properties, and verify that the Type field says Folder Shortcut. If so, go ahead and delete it. You can still access any node on the network through the Entire Network node or the Computers Near Me node. When you do, Windows will recreate the folder shortcut.

Don't Wait for a Welcome
Tired of the extra step the Windows XP Welcome screen represents? We don't recommend it, but you can make Windows XP boot directly into your main user account, bypassing the Welcome screen. It requires these precise conditions: exactly one user account, not password- protected, and no Guest account. But even if these criteria seem true, you may find that suddenly one day the Welcome screen starts appearing at start-up. This generally happens because of a Windows Update that adds a virtual user account called ASP .NET. This account is useful only to programmers—if you don't need the account, you can delete it from the Control Panel's User Accounts applet. Of course, the next Windows Update may well restore that account. And it's a really bad idea to configure your user account with no password.

Don't Wait for a Welcome: Multiuser Edition
You may want to boot directly to the default account, bypassing the Welcome screen, on a computer that has multiple user accounts defined. Select Run from the Start menu and enter control userpasswords2 to launch the User Accounts applet. Uncheck the box at the top whose title begins Users must enter a user name. (Note that if your computer is connected to a domain this box won't appear, and this solution does not apply.) Click OK and enter your username and password in the Automatically Log On dialog that appears. Click OK once more. Windows should now boot to the default account without requiring a password.

Whichever technique you used to bypass the Welcome screen, you won't lose access to the other user accounts. If you hold down the Shift key while Windows is starting, the Welcome screen will appear. You can also choose Log Off from the Start menu and then log on as another user.

No matter how you accomplish it, configuring Windows XP to boot without going through the Welcome screen leaves your system wide open to anybody with physical access to it. Unless the system in question is locked in a safe when not in use, you may be better off suffering through the drudgery of entering a password at start-up.

Best of User to User: Customization
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Reader: How can I make the Shift key turn off Caps Lock in Windows XP, the way it does on a typewriter?

PC Mag: Launch the Regional and Language Options applet from the Control Panel, click the Languages tab, then click the Details button. If the button called Key Settings is grayed out, click the Add button and add another keyboard definition, for example United States-International. Select the keyboard you normally use and click the Key Settings button. In the panel titled To turn off Caps Lock, select Press the SHIFT key. Click OK, OK, OK. Now you will turn off Caps Lock only by pressing one of the Shift keys—a second press of Caps Lock no longer turns it off.

Multiuser & Networks
ARTICLE DATE:  06.01.05
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When several people regularly use one computer, they'll probably want to set up multiple profiles to keep everyone's preferences straight, including bookmarks, screen settings, and My Documents folders. And when several people in the same house use their own computers, they'll probably end up networking the machines. Whether you're sharing one PC or connecting several, these tips will help you coexist peaceably.

Switch Users—Fast
It takes at least a few tedious seconds to log one user off and another one on. Windows XP has an option to speed that up: Fast User Switching (FUS) lets you switch without logging off. To enable it, open User Accounts in the Control Panel, click on Change the way users log on or off, and check the Use Fast User Switching box. Now, when you select Log Off, a Switch User option appears that lets you quickly change to another account without making any users close their programs. When FUS is enabled, holding down the Windows key and typing the letter L zips you to the Welcome screen.

Beware of the trade-offs of Fast User Switching, though. You should avoid running system-level utilities, such as defraggers or indexing utilities, when another user is logged on, and if you're looking for the best performance, you don't want to let idle accounts in the background tie up system resources. The feature is best for those times when you simply need to get in and out quickly. Also note that Fast User Switching does not work if your computer is a member of a network domain.

Limit Access to the Task Manager
To prevent users from killing important processes like antivirus scanning or usage monitoring, you can use the Group Policy Editor to disable the Task Manager. Log on as an administrator and launch Gpedit.msc using the Start menu's Run dialog. Navigate to User Configuration\Administrative Templates\System\Ctrl-Alt-Del Options. In the right-hand pane, double-click on Remove Task Manager and change its status to Enabled. You can still launch the Task Manager by right-clicking on C:\Windows\ System32\TaskMgr.exe, choosing Run As…, and using the Administrator password.

This works in Windows XP Pro; to accomplish something similar in Windows XP Home, which lacks the Group Policy Editor, log on to each user account and edit the Registry. In HKCU\Software\ Microsoft\Windows\CurrenTVersion\Policies\System, create a DWORD value named DisableTaskMgr, and set its data to 1. Do the same in the key HKEY_USERS\ Default\Software\Microsoft\Windows\CurrenTVersion\Policies\System.

Network Multiple PCS
If instead of multiple users using one machine you've got several PCs in one dwelling, you'll probably end up networking them, even if only to share an Internet connection. And guess what? Windows has networking set-up and troubleshooting tools. They're in the Control Panel's Network Connections applet. Select Set up a home or small office network and Windows will walk you through network configuration, helping you choose sensible settings.

If you're trying to fix an existing network, try the Network Troubleshooter in Windows Help and Support. It's surprisingly effective.

Troubleshoot Your Network
When you encounter a network problem, some of these command line tools can help you narrow down the source. From the command prompt:

  ping ipaddress (for example, ping 192.168.0.1) shows whether your PC can contact another computer or network device at a specific IP address. First ping your router to see if your LAN is working, then ping something on the Internet to see if the problem is outside. 

  tracert ip address (for example, tracert 192.168.0.101) reveals every router hop from your PC to another computer or network device. If you start seeing dropped responses, you may be able to tell whether the problem is local. 

  ipconfig /all shows all your computer's IP-related settings. If your PC is having trouble getting online, try ipconfig/renew to refresh your IP address or get a new one. 

  netstat gives you a list of all the active TCP/IP ports on your system—very useful in detecting whether a Trojan horse has commandeered your system. 

Best of User to User: Multiuser & Networks
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Reader: On my machine running Windows XP Pro, when I did a Fast User Switch, my dial-up Internet connection would disconnect. I found a fix for the problem. It turns out that the Internet Connection Sharing option works even for multiple users on the same computer. Here's how to set it up: From the Control Panel, launch Network Connections. Select the connection you want to share and click Change settings of this connection in the bar at left. On the Advanced tab, check the boxes Allow other network users to connect through this computer's Internet connection and Establish a dial-up connection whenever a computer on my network attempts to access the Internet. Now the connection will stay open through a Fast User Switch.

PC Mag: Microsoft's documentation verifies this. Always-on connections are unaffected by Fast User Switching. Dial-up connections will indeed be terminated unless Internet Connection Sharing is used. Other user-initiated connections, such as VPN connections, remain active while the Welcome screen is displayed. These will generally disconnect when a different user logs on, but may not do so in every case. If security is an issue, log out of any sensitive connections before allowing a Fast User Switch.

On-The-Go Tips
ARTICLE DATE:  06.01.05
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When it comes to computers, it's all about power, and notebook computers are no exception—it's just that power has a few more meanings on these PCs.

Set Power Options
On a desktop, power options are about convenience—how long should the system idle before starting the screen saver?—but they have a much more profound effect on laptops, namely on battery longevity.

You'll find Power Options in the Control Panel, and within it, several mobile-use–specific battery options, including Portable/Laptop, Super Power Saver, and Max. Battery. You can tweak these settings beyond the presets to determine how long the system waits to turn off monitors and hard drives, and when to stand by or hibernate (depending on whether it's plugged in or on battery power).

Use External Monitors
Laptop screens, especially on small, thin-and-light notebooks, can cause eyestrain with all-day, every-day use. You may want to connect a second monitor to your laptop to use instead of, or in conjunction with, the LCD screen that's already on the machine. As long as the graphics card can handle it—most laptops' can—Windows will make it very easy for you.

To start, plug the second monitor into the laptop's output port or docking station. Then find the hot key to send what's on screen to the external monitor. Depending on the notebook, pressing the hot key (typically, Fn plus an F-key) will either page through configurations much as Alt-Tab pages through your open windows, or simply activate the configurations, blanking the notebook display and activating the external monitor, then activating both.

You can also use the external display in concert with the internal display to extend your viewable display area. Right-click on the desktop and select Properties, then choose the Settings tab. You'll see both monitors represented in the dialog box. If the second monitor is grayed out, right click on it and select Attached. Set the screen resolution and color quality for this second display. Windows generally assumes that the external display is to the right, but if it's on the other side, just drag the on-screen representation to match your layout.

With that monitor still selected, make sure there's a check in the box labeled Extend my Windows desktop onto this monitor. Choose Apply and your desktop will take advantage of the additional screen space. It's that simple. You can now drag applications back and forth between the two displays.

Split the Difference Between Standby and Powering Down
When you go through a normal shutdown (clicking on Start then Shut Down), you're given a set of options, including Shut down, Restart, Stand by, and, if you've enabled it on your Win XP system, Hibernate. Hibernation saves the current state of your system to disk, so the system can completely power down but be restored to the same state when restarted. The battery doesn't drain in this state, but restarting won't be as quick as from Standby mode.

If the Hibernate option doesn't appear in your shutdown options, launch Power Options from the Control Panel, click on the Hibernate tab, and check the box labeled Enable hibernation.
Go Straight to Hibernate
We told you in the General Tips section how to create a shortcut to shut down your Windows system automatically. But you can create a simple command-based shortcut to do the job. Right-click on the desktop and select New | Shortcut. Type this case-sensitive command into the dialog box: rundll32.exe PowrProf.dll, Set
SuspendState.
Best of User to User: On-the-Go Tips
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Reader: I just bought a laptop that's supposed to run at 2.4 GHz, but when I checked the System Properties, the dialog indicated that it was a 2.4-GHz CPU and then said 957 MHz. I checked on several other computers. The same thing happened, though the speeds varied. One, for example, showed that it was a 2.4-GHz machine but running at 1.6 GHz. What's going on?

PC Mag: It's all about conserving battery life. Both mobile Pentium and mobile Athlon processors have power-saving capabilities that reduce the CPU's voltage and clock speed when running on battery power. And notebook vendors may customize these low-power settings to clock down the CPU to even lower voltages and CPU speeds.

For CPUs that support dynamically lowering speed and voltage on battery power, the power-management settings (Control Panel\Power Options) you choose will affect the processor speed. You can play around with these settings while on battery power to see whether they affect your CPU speed. Even on AC power, a CPU won't always run at its highest speed unless power management is set to Home/Office, Desktop, or Always On.
If your machine offers custom settings, your user guide should have specifics on what they do and how to set them. You can create a custom profile to fit your needs, but start with the Windows XP defaults and then vary them, so you know what effect each will have on the clock speed.

Internet Explorer
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The world's most prevalent browser can generally be operated without much thought. It likes to remember your passwords and type ahead for you, assuming you'll retype the same terms and URLs over and over. And it particularly likes staying installed, even going so far as to be unremovable.

Manage Saved Passwords
When you enter a Web site username and password in Internet Explorer, it may ask if you want it to remember the password. If you click Yes, it will store the password and automatically add it the next time you enter the username. But if you check Don't offer to remember any more passwords, then it won't offer to help in the future, whether you click Yes or No.

To recover this feature, launch Internet Options from IE's Tools menu, click the Content tab, click the AutoComplete button, and check the Prompt me to save passwords box. But pause before you do so—if the machine is not physically secure, you may want to uncheck the User names and passwords in forms box and click the Clear Passwords button to remove the stored passwords instead. For more sophisticated password and form management, see our reviews of form fillers and password managers, at http://go.pcmag.com/utilityguide .
Delete Items From Autocomplete Lists
When you start typing in a Web form, you may see a list of things you typed before—some of which may be private, inappropriate for work or family, or simply typed incorrectly. You can lose this baggage easily. While you're in the text box, use the down arrow (not the mouse) to scroll down and select that item. Then press the Del key to get rid of it. You can see all AutoComplete entries for a form field by clicking in the blank field and pressing the down arrow.

Pump Up the Address Bar Text
High-res screens are great—they fit much more information into the same amount of space—but when your display is set to a high resolution, reading the text in IE's Address Bar may be difficult. Here's the trick: The Address Bar uses the same font as the icon titles on the desktop. You can change these through Display Properties.

Right-click on the desktop, choose Properties, then click to the Appearance tab. Click on the Advanced button. In the pull-down Item list that appears, select Icon. Choose a more readable font and click on Apply. If the icon titles are now truncated, you can change Icon Spacing (Horizontal) and Icon Spacing (Vertical) to larger values.

Share IE Favorites
On multiuser machines, you may want to make all user accounts share the same bookmarks, so that any added bookmarks propagate to all users. To accomplish this, you'll have to tweak the Registry. First, select File | Import and Export and export your Favorites to a file. Then log on as each user and navigate to the Registry key HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrenTVersion\Explorer\User Shell Folders.

Locate the value named Favorites and change its data from the default of %USER
PROFILE%\Favorites to %ALLUSERSPROFILE%\Favorites. Then import the saved Favorites into any user account.

Cure IE's Window-Size Amnesia
It's a small problem but an annoying one: You may find Internet Explorer suddenly opening links in small windows. You can reset this easily.

Simply close all Internet Explorer windows. Open just one and Shift-click a link within it to open a secondary window. Adjust the secondary window to the size you want for all secondary windows. Then close it by holding Shift while clicking the X icon at top right. Size the primary window and close it in the same way. You may need to repeat this process if IE forgets after a while. Note that you can do the same for Windows Explorer, omitting the secondary window.

Block Internet Options
Unscrupulous Web sites or malicious programs can hijack your Internet Explorer home page, causing IE to start at a (usually) sleazy page. Anybody with access to your computer can do the same, or change other important settings. This dual Registry tweak offers some defense against unauthorized changes to your IE settings. Navigate to HKCU\Software\Policies\Microsoft\Internet Explorer\Restrictions and find or create a DWORD value named NoBrowserOptions. Double-click it and set its data to 1.

Now switch to the neighboring key HKCU\Software\Policies\Microsoft\Internet Explorer\Control Panel. Find or create a DWORD value named HomePage, and again set its data to 1. If you want to use Internet Options or change the home page yourself, you will need to change those two values temporarily to 0. Users of Spybot Search & Destroy, take note: "Immunize" options in this program set these values automatically.

Clean Up the Right-Click Menu
Internet Explorer's right-click context menu may contain items you don't need or ones that point to nonexistent programs. You can use the Registry Editor (regedit from Start | Run) to remove unwanted items from this menu.

In the Registry Editor, navigate to HKCU\ Software\Microsoft\Internet Explorer\MenuExt. You'll see a number of subkeys, each of which represents one of IE's context menu items. Simply select and delete any you don't want to see anymore.

Best of User to User: Internet Explorer
ARTICLE DATE:  06.01.05
By Sarah Pike 

Reader: In Windows XP, Internet Explorer 6, I need to restrict the browser to one specific domain, so the user can browse only to pages in this domain.

PC Mag: This can be done without third-party software. Browsers and other programs check the Hosts file to resolve domain names into IP addresses before they attempt to get the same information from a DNS server. If you disable DNS lookup, the Hosts file becomes a whitelist—only domains listed there will be accessible.

Open C:\Windows\System32\drivers\etc\Hosts in Notepad. Open a command prompt window and enter ping followed by the domain name you want to check, for example, ping www.ucdavis.edu. Append a line to the Hosts file consisting of the IP address revealed by the ping, a space, and the domain name, for instance, 169.237.104.199 www.ucdavis.edu . Add any more domains you want to allow (the POP3 or SMTP addresses used to access e-mail, for example). Save the Hosts file and close Notepad.

Launch Network and Dial-up Connections from the Control Panel, right-click the connection through which you access the Internet, and select Properties. Select TCP/IP in the components list and click the Properties button. On the General tab, note any existing DNS numbers and store them somewhere safe. Those numbers will be essential if you want to undo this modification. Check the box Use the following DNS connections and enter invalid DNS lookup addresses for Preferred DNS Server and Alternate DNS server—you can use 1.0.0.0 and 1.0.0.1. Restart the system. Any program that attempts to access a domain not listed in the Hosts file will fail. Truly determined users can log on to a "blocked" domain by entering its IP address instead of the domain name (though they won't be able to follow links). Still, this is a free solution and can be quite effective.

Best of User to User: Internet Explorer
ARTICLE DATE:  06.01.05
By Sarah Pike 

Reader: Is there any way to remove the saved username and password from a single Web site and keep all of my other saved password data? IE offers only to clear all the passwords from all sites.

PC Mag: To remove a stored username/password for a particular site, first navigate to the site. When Windows prompts you for the username and password, click in the username box and press the down arrow. This will show all the usernames stored for this particular site (usually just one). Press the down arrow until the name to be removed is highlighted and then press the Del key. Internet Explorer will ask whether you want to delete the username and password information. Click Yes and it's gone.

Mozilla Firefox
ARTICLE DATE:  06.01.05
By Sarah Pike 

Since the Mozilla Organization aimed its powerful weapon, the Firefox Web browser, at Microsoft, it has been gaining an ever-growing stake in the online market. Firefox's biggest gun is its customizability. Whether you are switching over for the first time, or are a seasoned user, here are some tips to enhance your browsing experience.

Import Away!
If you're changing browsers, or if you simply like having more than one on your system, there's an easy way to pull your other browsers' settings into Firefox. When you use the program's handy import tool, Firefox will grab the options, bookmarks, history, passwords, and other data from browsers like Internet Explorer, Netscape, and Opera. It's a real time-saver.

The Import function pops up during the initial installation of Firefox. Pick the browser you want to import your settings from, select what settings you want to import, and that's it. You're done. If you skipped this step when you first installed Firefox, just choose the Import function from the File menu.

But if you truly want to capture the fresh-from-scratch experience of switching browsers, you may want to uncheck the Cookies, Browsing History, Saved Form History, and Saved Passwords. Internet Options and Favorites are helpful to have when starting out, but this might be a good opportunity to do some spring cleaning of your stale old saved information.

Squint to Update
Unlike IE, Firefox won't update itself automatically when security patches are available. But updating the browser is a snap—once you realize an update is ready and waiting. Unfortunately, the diminutive upgrade notification icon is located inconspicuously in the upper right corner of the Firefox window. If any critical updates are available, the button looks like a white arrow on top of a red circle (the notification for updates to your extensions is blue). Click it and Firefox will begin the upgrade process. If there aren't any upgrades for anything you're running, said button will be barely noticeably absent.

Clicking on the easy-to-miss gray circle next to the upgrade button will take you to the Firefox home page, or Firefox Central. From there, you can take the initiative and personally update your browser with all the latest plug-ins, extensions, and themes; you can also check via the Tools menu—it's under Options | Advanced | Software Update.
You can also update your extensions and themes from their respective management windows. Click the Tools menu, then Extensions or Themes. From there, you can see a list of all the extensions and themes you have installed and individually check each one for updates.

Open Multiple Home Pages
You can take advantage of Firefox's tabbed interface right from the get-go, setting it to open multiple, tabbed pages on start-up—a handy tool for anyone who likes to sign on to a few favorite Web sites every day. Click on Tools | Options and the first thing you see should be the line for home page location.

Click in the text field, and type in the page you want Firefox to load first on the leftmost tab. After the address, insert a vertical bar (|) and type the next address. It's as easy as that. And there appears to be no limit to the number of pages you can designate to open; we got to 47 before our annoyance at the massive number of open tabs caused us to stop.

There's an even easier way to set up multiple home pages. When you're in Firefox, open all the tabbed pages you want to see on the browser's start-up. Go to Tools | Options again. Underneath the home page location bar is a button marked Use Current Pages. Click that and Firefox will automatically make all the currently open tabs your home pages.

Better Bookmarks
Whether you have three bookmarks or hundreds of them, Firefox has a few features that will ease your bookmarking experience. The newest version of the browser has simplified the processes for grouping bookmarks and opening multiple bookmarked pages. Now to open an entire folder's contents in tabs at once, just click on the Bookmarks menu, right-click on the desired folder, and select Open in Tabs.
Conversely, to save all of your open tabs at once, just click on the Bookmark menu and select Bookmark This Page. Though the window that pops up will prompt you for a name for the single bookmark, just pretend it's asking you for a folder name. Type that in, select the Bookmarks folder for a location, and make sure you click Bookmark all tabs in a folder. A new folder will appear in your Bookmarks menu containing all the tabs currently open in your browser. You can later go back and edit the properties of each bookmark, adding a short description to enhance your memory of just what each site was.

Use Keywords to Nickname Bookmarks
Another neat bookmark-related feature of Firefox is its ability to assign keywords to bookmarks. For example, you might assign the keyword ultrasweet to your www.pcmag.com bookmark.

It's a simple process. Click on the Bookmarks menu, right-click on a bookmark, and select Properties. In the Keyword field, enter the word of your choice. You can now use that word in place of the site's full URL in the address bar, and you'll be taken right to the page you saved.

Keywords II: but Wait, There's More
For certain search-based Web sites—Google, for example—you can actually use keywords to search straight from your address bar. For example, when you query Google normally, you're accessing the URL http://google.com/search?q=, where anything after the q= is the exact text you're searching for. Try adding that URL to your bookmarks folder, but modify it to read http://google.com/search?q=%s and assign it the keyword google. You can now type google x into your browser, where x is any search term you want to look up, like computers. You'll go directly to the results page, having saved a few steps in the process. This trick works for a lot of searchable Web sites; play around with it.

Be the Boss of Your Tabs
The uninitiated should know: Tabbed browsing quickly becomes a browsing requirement. It's just too convenient to give up. One common peeve of newbies, though, is that clicking on an external link, for example in an e-mail message, opens the link in the active tab, replacing the page you were on. Tabbed browsing was supposed to take care of that, right? It does. You just have to find the Tabbed Browsing options: Tools | Options | Advanced. You can elect to have external links open in a new window, in a new tab, or in the active tab. To open links from Web pages or bookmarks in new tabs, simply right-click on the links and select Open Link in New Tab.
Learn About About:Config
To peer into the brains of the Firefox browser, type about:config into the address bar and hit Enter. What follows is a large listing of the browser's internal configuration options, nearly all of which will make little sense to the average user. Luckily, Mozilla's all about online help, tutorials, and forums. We find http://kb.mozillazine.org/About:config particularly helpful—check the References links for more details than you can shake a stick at.

Speed It Up a Notch
One easy, cool preference you might want to tweak deals with speed. By default, Firefox runs fast enough—it's like driving at the speed limit. But if you want to push your browsing experience, modify a few settings in about:config. Note that these edits are for broadband connections only; if you're still dialing up, you're stuck with whatever speed you've got.

On the about:config screen, scroll down to the network.http.pipelining options. The name says it all: Firefox normally processes all HTTP requests sequentially. Once it sends one out, it waits for a response before sending the next request to a server. If you set network.http.pipelining and network.http .proxy.pipelining to true then you've basically just upgraded an antiquated browsing system with modern plumbing. Set the network.http.pipelining.maxrequests option to 30 and Firefox will now send up to 30 HTTP requests at once—theoretically, although not always, making your browsing that little bit faster.

Before you close the window, right-click anywhere on the about:config page and select New | Integer. Then type in nglayout.initialpaint.delay and enter 0 as its value. Firefox will now render pages immediately instead of waiting its default 250 ms, a slight but noticeable difference when you're surfing the Web.

Feed Me
RSS readers are quickly becoming the best tools for staying up to date with the latest postings on your favorite Web sites and blogs. (You can subscribe to PC Magazine's RSS feeds at http://go.pcmag.com/rss .) Mozilla built a full RSS reader into its Thunderbird mail client, but Firefox can make use of RSS as well.

You may have noticed a button called Latest Headlines on Firefox's Bookmarks toolbar. When you click on the button, you're presented with a dynamically generated list of links to current news stories. This is what Firefox calls a Live Bookmark, and it's generated by an RSS feed. You can click through to any link on the list, or open every item all at once.

When you visit a site that has a feed, you'll see a little Live Bookmark icon in the lower right of the browser window. Click the icon and you'll see a list of all published feeds. Choose the feed you want and Firefox asks where it should store the Live Bookmark. Choose Bookmarks Toolbar Folder from the Create in drop-down menu and, voilà, a button for the feed appears on the toolbar. Now you can check for the latest news whenever you want.
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